

    
      
          
            
  
Welcome to LimestoneNetworks Documentation!

We are a Dedicated and Cloud Hosting company. Here you will find information
about most of the technologies we use in managing our infrastructure.
We use Openstack for our cloud, Ansible for orchestration etc.
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Do you offer DDoS Protection?

We offer two levels of network attack protection.

Basic Protection, Free

– Basic protection using a defined set of filtering rules. If mitigation is
possible using the predefined rules, it can take up to 5 minutes for traffic
to return to normal. If the automatic detection was unable to automatically add
the filter, we can certainly analyze your traffic and add the filter to
which-ever IP needs it.

Enterprise Protection, $50/month per IP

– This protection is always-on and detects attacks within seconds. It protects
up to 20Gbps and 12 million packets per second. It not only filters attacks it
knows about, but also has the capability of automatically learning new attack
methods and block them real-time.

For more information regarding our DDoS protection please see our service
page [https://www.limestonenetworks.com/data-center/ddos-protection.html]
and, for more technical information, download the whitepaper [https://www.limestonenetworks.com/docs/ddos_mitigation.pdf]
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How does DNS operate?

How DNS operates / basic record management

DNS stands for Domain Name Service. It is the system in which a domain name
is converted into an IP address (in most cases). It all starts when you
purchase a domain through a registrar, (Ex:
godaddy.com [https://www.godaddy.com/]).

As for the remainer of this article, we’ll call your domain “MYDOMAIN.COM”.

The primary role of a name-server is to handle requests, it accepts domain
queries and returns a ‘record’. There are 2 most commonly used
‘records’, they are:

- (A) Record – This determines that IP Address of a domain, as an (Ex: When
you enter a domain into your browser (Ex: Internet Explorer), your computer
contacts a name-server, in which that name-server replied with an IP address of
the domain you are trying to reach. Then your browser connects to that IP
address.)

- (MX) Record – This determines which e-mail server handles e-mail for this
domain. (Ex: You are sending an e-mail to support@limestonenetworks.com, the
@limestonenetworks.com shows which domain the user support is at. The
e-mail client will connect to your name-server and retrieve the ‘MX’ record,
which is the Limestone Networks e-mail server.)

Summary


	DNS stands for Domain Name Service.


	The domain registrar determines which name-server handles request for a
particular domain.


	The basic operation of DNS is for the name-server to return information
about a domain.


	There are 2 most commonly used records.




Using Limestone’s name-server(s)

Please visit How do I use Limestone’s DNS service [http://limestonenetworks-knowledge-base.readthedocs.io/en/latest/limestone_addon_services/dns_rdns/lsn_dns.html]

Our Control Panel

This section details how to create the most common records in our control
panel.

Creating an A Record in our Control Panel

In order for your domain to resolve to your web server you will need to create
an Address (A) Record for your domain in our control panel.

Under the DNS Tab in our control panel click on your domain, then click Add a
Record. You will be creating two records. One so mydomain.com will resolve to
your web server and another for www.mydomain.com For the first record leave the
Host field blank, the Type: is Address (A), and then in the Address/Text field
put your web server’s IP address. You can leave the TTL at its default. Now you
will follow the same steps again except you will enter www in the Host field.
Keep in mind the trailing . is already present after the field.

Using your own name-server(s)

In order to setup your own name-servers, such as:


	ns1.MYDOMAIN.com


	ns2.MYDOMAIN.com, etc




You’ll need to do the following:


	
	Setup DNS service on your server.

	
	This can be a multitude of services, and the operating system can be
nearly anything.. Linux, Windows, or Unix. Here are a few various
programs for *nix based operating systems:
- BIND
- DJBDNS










	Set your domain registrar’s name-servers to your nameservers and allow enough
time to propogate:


	ns1.MYDOMAIN.com


	ns2.MYDOMAIN.com






	Modify your system records with domain records and allow enough time to take
effect.









          

      

      

    

  

    
      
          
            
  
How do I use Limestone’s DNS service?

We provide 3 managed redundant name-servers for your convenience, If you don’t
want the trouble of creating your own nameservers (eg: ns1.MYDOMAIN.com), you
can use the DNS Panel located under the Control Panel
https://one.limestonenetworks.com/dns/

Nameservers

Before editing domain DNS information under the control panel, you must change
your domain registrar’s name-servers for your domain to:


	ns1.limestonenetworks.com


	ns2.limestonenetworks.com




We also provide whitelisted DNS services using the following nameservers:


	ns1.dallas-idc.com


	ns2.dallas-idc.com




After setting these as your nameservers under your domain registrar, please
allow between 24 – 48 hours for the name-server records to fully propagate.

Now you can continue modifying domain records via the Control Panel.

Changes made under the control panel are not immediate, please allow up to
30 minutes for the records to update. However, some changes may be active after
as little as 5 minutes.

Summary


	Set domain registrar’s name-server records to Limestone’s nameservers.


	Wait 24 – 48 hours for the changes to take place.


	Modify domain information under the Control Panel.


	Allow time for changes to take effect.









          

      

      

    

  

    
      
          
            
  
What is rDNS?

rDNS is Reverse DNS.

rDNS operates in the exact opposite direction of DNS, it converts IP addresses
into domains.

What do we need rDNS for?

One great use of rDNS is for e-mail servers. Example:


	Your e-mail server mail.yourdomain.com contacts mydomain.com’s
mail server.


	mydomain.com resolves mail.yourdomain.com into 172.22.0.1, in
order to send information back to the server.


	However, mydomain.com has security measures.. It wants to make sure
172.22.0.1 really is mail.yourdomain.com, so it performs a rDNS lookup.


	172.22.0.1 turns out to resolve to mail.yourdomain.com, so it sends
it’s data.




How do I modify rDNS records for my IP(s)?

The control panel enables the customer to modify rDNS entries directly to their
IP address(s), via http://one.limestonenetworks.com/dns/reversedns.html.






          

      

      

    

  

    
      
          
            
  
How do I set up rDNS?

You have the power of creating/deleting/modifying rDNS entries directly from
your Control Panel at https://one.limestonenetworks.com/dns/reversedns.html

When making changes to rDNS entries, please allow up to 48 hours for everything
to fully propagate.

If you have any more questions regarding rDNS please visit What is rDNS? [http://limestonenetworks-knowledge-base.readthedocs.io/en/latest/limestone_addon_services/dns_rdns/reverse_dns.html]
where you will find resources to help you with rDNS. If additional assistance
is required, simply let us know.






          

      

      

    

  

    
      
          
            
  
IPv6 rDNS

Limestone uses delegation when it comes to IPv6.

Currently, One Portal does not support adding IPv6 rDNS entries.

If you would like to have rDNS configured on your IPv6 addresses you’ll
need to open up a Support ticket with the nameservers you would like the
DNS delegated to.






          

      

      

    

  

    
      
          
            
  
KVMoIP


Contents:


	How do I access my server’s IPMI?

	IPMI issues with Java 8

	Does my server come with KVMoIP?

	How do I install an OS through my IPMI?









          

      

      

    

  

    
      
          
            
  
How do I access my server’s IPMI?

All E3- and E5-based dedicated servers offered by Limestone Networks come with
a built in IPMI. This device allows you console-level remote access and control
of your server, as well as monitor system hardware and keep up with system
alerts.

Before attempting to access your IPMI, you will need to configure and log in to
the Limestone Private Network via your VPN. You may find a tutorial on install,
configuration, and access here [http://limestonenetworks-knowledge-base.readthedocs.io/en/latest/limestone_addon_services/vpn/windows_openvpn_setup.html].
Please note that you will not be able to access your IPMI unless you are
actively connected to the Limestone Private Network via IPMI – this is for your
security and to prevent unauthorized IPMI access from the outside world.

To access your IPMI, enter the One Portal control panel and navigate to the
Services -> Service Packages page. From there, select the Tools dropdown for
the server that you wish to utilize the IPMI of, and choose Launch KVMoIP.

[image: ../../_images/kvm_image1.png]
Once you have clicked this option, you will be taken to a login page for your
IPMI. You simply log in using the same credentials that you use to log into One
Portal, but please be aware that passwords in excess of 16 characters will
cause issues with the IPMI and will not be able to log in. If this is the case,
you will need to change your password via One Portal, fully log out of all
Limestone Networks-affiliated pages, and wait 5 minutes for the change to
propagate through our systems.

[image: ../../_images/kvm_image2.png]
Once you have logged into the IPMI, to take remote control of the server,
choose Remote Control -> Console Redirection (on older models) or Remote
Control -> Remote Console (on newer models). This will download a .jnlp applet
launcher – you will need to have the latest Java Runtimes installed, and the
IPMI will prompt you for this if this is not detected.

[image: ../../_images/kvm_image3.png]
[image: ../../_images/kvm_image4.png]
Once you have downloaded and launched the .jnlp file, you are now connected to
your server’s IPMI KVM over IP remote console. You have full mouse and keyboard
access to the server, as if you were physically right next to it.

Please be aware that due to the way that Supermicro deploys self-signed
certificates for IPMIs, you may need to acknowledge an “unsafe” connection in
your web browser and/or through Java. As this is being routed through our
secure VPN and the Limestone Private Network, you can be confident that your
connection and data is safe and secure.
If you are unable to access your IPMI for any reason, or attempts to launch
the .jnlp file return with “Connection Failed”, please open a support ticket [https://one.limestonenetworks.com/support/newticket.html] with as much
information as possible and we will be glad to assist you.






          

      

      

    

  

    
      
          
            
  
IPMI issues with Java 8

With the new Java 8 rolled out, it has been discovered that it can block access
to SuperMicro IPMI interfaces, if it doesn’t meet the minimum security
requirements.

Below are the steps that can be taken to fix this. This solution should work
for Windows 7 64bit, Windows 7 32bit, Windows 8 64bit, and Windows 8 32bit.
This fix may need to be implemented before each remote control session via a
SuperMicro IPMI.



	Go to the Start Menu


	Choose Java


	Click Configure Java


	You should be on the General tab


	Click Settings…


	Click Delete Files…







Make sure both “Trace and Log Files” and “Cached Applications and Applets” are
check marked and “Installed Applications and Applets” is unchecked.



	Press OK


	Click Security


	On this page, make sure that the Java security level is set to the High
setting.


	Click Edit Site List, then add the IP address of the IPMI to the
Exception Site List….


	Click Apply


	Press OK again on the General tab to exit


	Open the Remote Control session,  and you should then be able to use the
IPMI.












          

      

      

    

  

    
      
          
            
  
Does my server come with KVMoIP?

It’s very possible.

All of Limestone’s Intel Xeon servers come with integrated IPMI. This IPMI
interface gives you access to great features including KVMoIP. If you don’t
know how to connect to your IPMI interface, open a Support ticket and we’ll
gladly point you in the right direction.

If your server is not an Intel Xeon server, we offer KVMoIP based on how long
you’d like it.






          

      

      

    

  

    
      
          
            
  
How do I install an OS through my IPMI?

IPMI Virtual Media

How To For Single CPU Xeons (X3400)

1. Login to the IPMI interface by using https://[ip-address] in any browser.
You should have been provided the IP address of your IPMI interface in your
Welcome E-Mail or Provisioning Ticket. If you do not have this URL please
open a support ticket. The username and password is the same as your
control panel login.

[image: ../../_images/Ipmi_login.png]
2. After you login go to Remote Control > Console Redirection, and then click
Launch Console. This will launch a Java Console interface.

[image: ../../_images/Ipmi_console.png]
3. After a few seconds a toolbar should load in this Java window.
Click Virtual Media in the top left hand corner and then Virtual Storage.

[image: ../../_images/Ipmi_vm.png]
4. Go to the CDROM&ISO Tab and chose ISO File as the Logical Drive Type.
Then click Open Image and select the .iso file from your computer.
Once it has been selected click Plug in and click OK.
The ISO file should now be connected to the computer.

[image: ../../_images/Ipmi_oi.png]
Setting The BIOS

You will need to press F10 or F12 to enter the boot Menu and then Select
Boot from USB-CDROM. Setting it in the BIOS as your first boot device
will not work. The BIOS does not detect it, and skips over it initially.
Legacy USB Storage Detect MUST be enabled.






          

      

      

    

  

    
      
          
            
  
NAS


Contents:


	cPanel errors with scripts stored on NAS

	How do I set up my NAS account?

	What can I use the NAS for?









          

      

      

    

  

    
      
          
            
  
cPanel errors with scripts stored on NAS

When using a cron script executed by cPanel that is stored on the Limestone
NAS, you will need to modify the mount command to include the uid and gid of
the cPanel user which is running the bash script.

For example:

mount -t cifs -o username=cli\
 ####,password=yourPassword,uid=yourCpanelUid,gid=yourCpanelGid, \
file_mode=0755,dir_mode=0755 //74.63.205.205/nas.nas.cli
 #### /mnt/nasCpanelUser





For more information about Limestone’s NAS, please visit our articles
Limestone Networks NAS [http://limestonenetworks-knowledge-base.readthedocs.io/en/latest/limestone_addon_services/nas.html].






          

      

      

    

  

    
      
          
            
  
How do I set up my NAS account?

Setting up access to your NAS account is pretty simple. All of the information
and steps can be found in OnePortal.

Before you start, make sure that Samba is installed in Linux if you are using a
Linux operating system.

Then, visit OnePortal’s Shared NAS [https://one.limestonenetworks.com/servers/sharednas.html] page and click
the (?) icon next to the share you would like to mount. Further instructions
are provided there.

Only Accessible Internally

The NAS is only accessible over the private network. If you wish to store files
on it remotely, you would need to setup FTP (or some other file transfer
server) and map it to the mount point of the NAS on your server. You would then
connect to your server to access it.






          

      

      

    

  

    
      
          
            
  
What can I use the NAS for?

NAS (Network Attached Storage) can be used to store files for:


	Incremental Backups


	Additional Storage


	Transfer / sync files between servers




Limestone’s NAS systems are on Limestone’s Private Tunnel [http://limestonenetworks-knowledge-base.readthedocs.io/en/latest/limestone_addon_services/vpn/limestone_private_tunnel.html] which means you get unmetered free transfer between your NAS space and your servers.
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Configuring Softaculous with WHMCS to Auto Install Client Websites

This guide will help you integrate your Softaculous installation with WHMCS to
automate your web hosting business. This can only be configured with WHM
servers [http://limestonenetworks-knowledge-base.readthedocs.io/en/latest/limestone_addon_services/software/install_softaculous_whm.html]
and DirectAdmin servers currently.

Install the Hook in WHMCS


	Download the Softaculous Auto Installation Hook. It is available from
WHMCS Community Addons [https://www.softaculous.com/docs/File:Autoinstall.zip]


	Extract the file softaculous.php and upload it to
/full_path_to/whmcs/includes/hooks/


	Optionally, upload the file softaculous_debug.php to
/full_path_to/whmcs/includes/hooks/


	Remove the file softaculous_debug.php from the hooks directory after
testing




Note: The softaculous_extra.php file adds Auto Installation capabilities
for custom scripts. Otherwise, you do not need to upload this file.

Activating the Hook with Your Hosting Plans


	Login to your WHMCS administrative panel.


	Go to Setup -> Products/Services -> Products/Services and select the Icon to
edit the hosting plan for automated installs


	Under the Custom Fields tab, you will need to add 4 custom fields






	Custom Field #1






	Field Name: Script


	Field Type: Drop Down


	Description: Select the script to install


	Validation:


	Select Options: (comma-separated scripts list)**








	Custom Field #2






	Field Name: Admin Name


	Field Type: Text Box


	Description: Select your Admin Name for the script


	Validation:


	Select Options:








	Custom Field #3






	Field Name: Admin Pass


	Field Type: Text Box


	Description: Select your Admin Pass for the script


	Validation:


	Select Options:








	Custom Field #4






	Field Name: Admin Pass


	Field Type: Text Box


	Description: Select the directory you want to install the script at


	Validation:


	Select Options:











	For the Hook to work properly, the custom fields should be entered exactly
as above




Here is a list of popular scripts, which are comma-separated for your
convenience:

None, WordPress, b2evolution, StatusNet, Drupal, Mambo, phpBB, SMF, AEF,
Coppermine, Gallery, Jcow, OpenClassifieds, openX, WebCalendar, Shadows
Rising,
phpList, SquirrelMail, LimeSurvey, Piwik, SugarCRM, PHProjekt, osCommerce,
Magento, phpBook, HESK, osTicket, kPlaylist, VidiScript, Gregarius,
CodeIgniter, Moodle, Elgg

Setup when the Module Runs

The Hook will run to auto install the scripts only when an account is being
created. To modify when this takes place, go to Setup -> Products/Services ->
Products/Services and choose the hosting plan for automation.

Select your desired settings and hit the “Save Changes” button.

Testing the Module

Initiate an order from a Dummy Account. Ensure that the Admin Name and Admin
Pass are setup and that a script is selected.

Then click on the “Create” button to create the order.

You should see a box on the page that reads: “Are you sure you want to run
the create function?”

Confirm this action by clicking the “Yes” button.

If the module was successful, you will see the message “Script Installed
successfully”

If the hook was unsuccessful, you will see “Installation not completed”
followed by the error given

When you are finished testing the module, remove the softaculous_debug.php
file from your WHMCS installation






          

      

      

    

  

    
      
          
            
  
Install Softaculous on a WHM Dedicated Server

This guide will show you how to install Softaculous on a WHM dedicated server [https://www.limestonenetworks.com/dedicated-servers/bare-metal.html].

Before the Installation


	Obtain a licensed WHM server


	If you have a firewall, whitelist IPs to download and update Softaculous
scripts


	api.softaculous.com [http://www.softaculous.com/] (IP : 216.18.221.243)


	s1.softaculous.com [http://www.softaculous.com/] (IP : 192.99.110.112)


	s2.softaculous.com [http://www.softaculous.com/] (IP : 76.164.222.115)


	s3.softaculous.com [http://www.softaculous.com/] (IP : 76.164.201.252)


	s4.softaculous.com [http://www.softaculous.com/] (IP : 138.201.24.83)


	s7.softaculous.com [http://www.softaculous.com/] (IP : 104.250.159.187








Installing Softaculous

Enable ionCube Loaders


	In WHM (as root user), navigate to Server Configuration -> Tweak Settings ->
PHP


	Enable the loader by placing a check in the box next to “ioncube”


	Click ‘Save’




Once you have enabled the ionCube Loaders, SSH into your server and enter the
following commands:

wget -N http://files.softaculous.com/install.sh
chmod 755 install.sh
./install.sh





Now visit your WHM web interface.

Navigate to Plugins -> Softaculous – Instant Installs.

If the installation was successful, you will see the home screen of Softaculous
displaying the Software Info

Installing with Proxy Settings

If you need to install Softaculous using proxy settings then you can pass the
parameters using the command below:

wget -N http://files.softaculous.com/install.sh
chmod 755 install.sh
./install.sh proxy proxy_ip=YOUR_IP:PORT proxy_auth=USERNAME:PASSWORD





Proxy Parameters:


	proxy_ip : Enter your Proxy server’s IP and port


	proxy_auth : Enter the proxy server’s authentication details (Username and
Password)









          

      

      

    

  

    
      
          
            
  
How much is Parallels Plesk Panel for cloud servers?

Parallels Plesk Panel licensing for cloud is exactly like a
dedicated server [https://www.limestonenetworks.com/dedicated-servers/bare-metal.html].
We offer Parallels Plesk Panel in four different editions.


	Web Admin Edition – $0.005/hour


	Web App Edition – $0.006/hour


	Web Pro Edition – $0.011/hour


	Web Host Edition – $0.027/hour




Learn more about your options on our
Plesk Panel 12 Hosting [https://www.limestonenetworks.com/upgrades/parallels-plesk-panel.html]
page.






          

      

      

    

  

    
      
          
            
  
Do you offer VMware ESXi?

Yes!

We have recently added VMWare ESXi as a supported operating system. We also
support automated reloads of this operating system from within our control
panel.

You will need to
register [https://www.vmware.com/try-vmware.html?PID=8346037&PubCID=4917229]
on VMWare’s website in order to retrieve a license key. Once you have
received your license key you can follow this guide [https://kb.vmware.com/s/article/2014295?sliceId=1&dialogID=499852417&docTypeID=DT_KB_1_1&stateId=1+0+499856347#.VMuPCj-oGTg.link]
on entering it. This is done from within the vSphere client under the Home >
Inventory Configuration Tab.

If you do not obtain a license key your VMWare ESXi evaluation period will
expire and your installation may cease to function.






          

      

      

    

  

    
      
          
            
  
How to whitelist an IP for WHMCS API.

You may find that you need to add an IP address to the WHMCS whitelist in
order to connect certain applications. Here is a guide:


	Login to your WHMSC


	Go to Setup -> General Settings


	Click on the Security tab


	Find the “API IP Access Restriction” box


	Click the “Add IP” button and put in the IP address






	For example if you are connecting OnePortal to use the plugin on the
Dashboard, you would add the IP address 64.31.0.178.








	Press Save Changes when finished.









          

      

      

    

  

    
      
          
            
  
How much is cPanel for cloud servers?

cPanel costs $11.77/month or roughly $0.016/hour on our cloud servers.






          

      

      

    

  

    
      
          
            
  
Instant cPanel VPS Licenses

Limestone allows you to perform your own cPanel VPS license maintenance.
You may add and delete licenses from your control panel by doing the
following:

Add a license:


	Login to our control panel


	Go to your Servers -> Control page


	Click “Package Details” under the server you would like to register
the license for


	Below the heading “Add a cPanel License” put in the IP Address you
would like to license


	Press “Add License”




After performing these steps, your license will be instantly activated.

To remove a license:


	Login to our control panel


	Go to your Servers -> Control page


	Click “Package Details” under the server you would like to register
the license for


	Click the red “X” next to the VPS license you would like to remove




After performing these steps, your license will be instantly deactivated.

If you have any other questions or experience difficulties, please let us know.






          

      

      

    

  

    
      
          
            
  
SSL Certificates


Contents:


	Acquire an AutoInstall SSL voucher

	AutoInstall SSL Plugin Installation for cPanel

	Uninstall OneClickSSL for cPanel/WHM

	AutoInstall SSL Plugin Installation for Plesk

	RapidSSL Certificates

	Comodo Positive SSL Wildcard Certificates

	GeoTrust Quick SSL Premium Certificates

	Symantec Secure Site with EV

	AutoInstall SSL (cPanel) Auto Update Guide









          

      

      

    

  

    
      
          
            
  
Acquire an AutoInstall SSL voucher

Limestone Networks uses the AutoInstall SSL platform to provide our partners
all SSL certificates. Along instant RapidSSL certificates you can now choose
from VeriSign® (Symantec™), GeoTrust®, Thawte, RapidSSL, Comodo and TrustWave
directly from us and get better pricing than if you were buying from the
vendor. Please review the details below to acquire your SSL certificate.
You can also install your certificates manually, if desired.

Before getting started, you will need to make sure you have the AutoInstall
SSL plugin loaded on your cPanel/WHM or Plesk installation. Details on how to
download and install these plugins are located here:


	How to install AutoInstall SSL for cPanel/WHM [http://limestonenetworks-knowledge-base.readthedocs.io/en/latest/limestone_addon_services/ssl/autoinstall_ssl_plugin.html]


	How to install AutoInstall SSL for Plesk [http://limestonenetworks-knowledge-base.readthedocs.io/en/latest/limestone_addon_services/ssl/autoinstall_ssl_plugin_plesk.html]




Our support team can install the plugin for a per-incident management [https://www.limestonenetworks.com/support/management-per-incident.html]
ticket fee.

Once the plugin is installed:



	Login to OnePortal [https://one.limestonenetworks.com/]


	Click on “Services” in the main navigation, then “Licenses [https://one.limestonenetworks.com/servers/licensing.html]” in the
sub-navigation


	Click the “Register a License” button


	Select the License Type “SSLStore Voucher”


	Select the Server the SSL certificate will be added to


	Type of Domain Name that the SSL certificate will be for


	Press “Get License”


	Press the “Show Key” button next to your new AutoInstall SSL Voucher


	Copy the Voucher code and enter it into the plugin on your control panel







If you would like to install the certificate manually, please contact our sales
department.






          

      

      

    

  

    
      
          
            
  
AutoInstall SSL Plugin Installation for cPanel


	Download the plugin from here [http://mirror.lstn.net/limestone-sslstore/cPanel_AutoInstallSSL_latest.zip]


	Copy the autoinstallssl folder from the zip file to your WHM/cPanel
server, it requires no specific location.


	As the root user, run the install command at the prompt:




cd autoinstallssl
chmod 777 install
./install






	Activate ionCube loaders from WHM panel.
Go to “Tweak Settings “ menu under “Server Configuration “
Click on PHP tab.
Check the ionCube option and click on save.


	Complete the
AUTO-UPDATE [http://limestonenetworks-knowledge-base.readthedocs.io/en/latest/limestone_addon_services/ssl/autoinstall_ssl_cpanel_auto_update_guide.html]
setup to ensure functionality in future versions.









          

      

      

    

  

    
      
          
            
  
Uninstall OneClickSSL for cPanel/WHM

To uninstall, run these commands while logged in as the root user:

chmod +x /usr/local/cpanel/scripts/GlobalSign-Uninstall
/usr/local/cpanel/scripts/GlobalSign-Uninstall










          

      

      

    

  

    
      
          
            
  
AutoInstall SSL Plugin Installation for Plesk


	Download the plugin from here


	Login to your Plesk Panel


	Click on Extensions under Server Management on the left hand panel.


	Click on Add Extension


	Browse the Plesk_AutoInstallssl.zip file and click on OK.


	Now you can see the link of “AutoInstall SSL” plugin under Extensions
Management.


	To go to the plugin page, click on that link or click on the left hand panel
link under Links to Additional Services.


	Click AutoInstallSSL — Now you will see the plugin page, and installation
is complete!









          

      

      

    

  

    
      
          
            
  
RapidSSL Certificates

Secure Your Site Fast, for Less
RapidSSL® Certificates help you keep your customers’ transactions secure with
strong encryption, and you’ll speed through enrollment with automated domain
control validation. We keep our costs down and pass the savings on to you.

RapidSSL Features


	Fast issuance and easy install


	99+% browser support


	Up to 256-bit SSL encryption


	Free support by web and email


	$10,000 warranty


	7-day money back guarantee!









          

      

      

    

  

    
      
          
            
  
Comodo Positive SSL Wildcard Certificates

128 bit SSL Certificates designed for encrypting web sites for low volume
online transactions. Secure multiple subdomains with one certificate. Trusted
by over 99.3% of current Internet users, Positive SSL is the solution for new
websites or environments where trust has been established and entity
verification (for identity assurance) is not needed. Positive SSL Certificates
carry a $10,000 warranty.

Buy New OR Renew Your PositiveSSL Certificates

Speed of Issuance & Validation Levels:

Positive SSL provides domain validation but do not authenticate the business
behind the online business. However, in order to provide critical identity
assurance for your site, every Positive SSL comes with FREE registration in
IDAuthority. IDAuthority is world’s first and unique real-time identity
assurance service developed by Comodo that allows website identities to be
verified against registry and public data. This validation process delivers
identity assurance so customers will trust you and be confident buying on your
site.


	Secure multiple subdomains with one certificate


	Domain validated certificate


	2048 bit Industry Standard SSL Certificate


	Trusted by all popular browsers


	99.3% browser compatibility


	128/256 bit encryption


	30 day Refund Policy


	Email and web support


	Starting at only $149.00 per year


	Unlimited Re-Issuance Policy




Price:

Starting at only $125.00 per year, Positive SSL Wildcard is one of the most
cost effective Wildcard SSL Certificates available today. SSL certificates can
be purchased for a term of up to 3 years for further discount.

Build customer confidence in your website

By displaying a PositiveSSL seal on your site, you instantly inform your
customers that you use 128 bit SSL encryption to protect confidential data,
(e.g. credit card information) during online transactions.

Industry Leading Expert Support:

Comodo, the company behind this SSL certificate, has a well-earned reputation
for industry leading customer care and technical support. As a valued SSL
customer, you can expect prompt support for any issues you may face or
questions you may have during any stage of applying for, installing or using
your SSL Certificate.






          

      

      

    

  

    
      
          
            
  
GeoTrust Quick SSL Premium Certificates

Secure your website fast. GeoTrust® QuickSSL® Premium certificates are one of
the quickest ways for you to start protecting online transactions and
applications with SSL. With an automatic authentication and issuance process,
it takes just minutes to get your QuickSSL Premium SSL certificate. After that,
managing and renewing your certificates is a snap. With GeoTrust, you get
inexpensive SSL without sacrificing convenience, choice, or reliability.

Buy New OR Renew Your GeoTrust QuickSSL Premium Certificates

Key Benefits


	Save time and money with inexpensive, easy, and convenient SSL


	Show customers you care about their security by getting your SSL from a
credible security company


	Get more for your money with unlimited licenses, free reissues and the
GeoTrust reputation




Features


	Security: domain control validation, strong 256-bit encryption, 2048-bit root


	Assurance: $100K USD warranty, GeoTrust dynamic True Site Seal Trustmark


	Convenience: issued in minutes, 1 -6 year validity options


	Cost-effective: unlimited server licenses, unlimited free reissues for
certificate lifetime


	Universality: support for more than 99% of browsers and most mobile device
browsers


	Bonus: secure domain.com for free when you order www.domain.com




Price:

Starting at only $125.00 per year, Positive SSL Wildcard is one of the most
cost effective Wildcard SSL Certificates available today. SSL certificates can
be purchased for a term of up to 3 years for the further discount.

Need to secure multiple domains? Contact our sales department for assistance.






          

      

      

    

  

    
      
          
            
  
Symantec Secure Site with EV

The Symantec Trust™ Seal shows the world that Symantec has confirmed your
identity and your site has passed the VeriSign malware scan. The biggest
companies in the world secure their Web sites with Symantec (VeriSign) and
inspire confidence by showing the Symantect seal. Now any Web site can build
trust, credibility, and loyalty online with the VeriSign seal.

Buy New OR Renew Your VeriSign Trust Seal


Note: If your Web site uses SSL, you must use VeriSign SSL in order to
display the VeriSign Trust Seal.




Features and Benefits

Increase traffic, sales and loyalty online by showing customers they can buy,
browse, and share with confidence because your Web site is trusted by Symantec,
the global leader in online trust. Symantec now includes a free SAN for your
base domain name with this certificate, which means you can secure www & non
www versions with single Symantec Secure Site with EV SSL certificate. In
total, you can secure up to 25 domain names with this certificate.


	Display the #1 trust mark on the Internet: VeriSign Trust Seal shows your
site visitors that you are trusted by the leader in online trust and gives
them the confidence to buy, click, and sign in.


	Establish your business legitimacy: Authentication is an established and
proven process used by Symantec that shows the world that Symantec (VeriSign)
has verified your identity and that you are the rightful owner or operator of
your Web site.


	Protect visitors and your site from malware: Web site malware scan is a
daily review of your Web site to help protect it from being blacklisted by
search engines and to reduce the risk of infecting your customers’ computers
when they browse your Web site. Learn more: Malware FAQ


	Stand out in search results: Symantec Seal-in-Search™ is a Symantec
(VeriSign) seal displayed near your link in search results to help you
stand out from the competition and help increase traffic to your site. At
theFind.com, VeriSign Seal-in-Search helped increase click rates by an
average of 18.5 percent.


	Extended Validation, Green Address Bar


	Secure up to 25 Domains ( Multi SAN Certificate)


	Symantec Secure Site EV covers both www & non-www versions.


	High 256-bit encryption 2048 bit root Certificate


	99.9% Browser Recognition Rate


	Supports Mobile Devices


	Secure Site EV SSL Carry warranty of $1,750,000 – highest in industry


	FREE Norton™ Secured Seal


	Includes Reissuance Insurance


	FREE Installation Checker


	FREE Vulnerability Assessment & Actionable Report


	FREE Daily Symantec™ Malware Scanning (behavioral/predictive)


	FREE 24/7 Technical Support


	30 Day Money Back Guarantee!


	Supports 3 encryption algorithms, RSA, DSA


	Secure Multiple Domains on a Single IP Address**

** Applicable to a server that supports SNI (Server Name Indication).





Easy Install

Installing the VeriSign Trust Seal is as easy as adding an image to a Web page.
After you apply for the seal, VeriSign verifies your business information and
scans your Web site. When your seal is ready, you’ll receive an email alert.
Go to the Installation Agreement to accept the terms and conditions.


	Choose a display language and size for your seal and enter your Web site
name.


	Click “Create your script”, then copy the script and paste it directly into
your Web pages.


	Check your Web page. The javascript automatically displays a dynamic Symantec
Trust™ Seal.




Price:

Starting at only $799.00 per year, Symantec Secure Site with EV is the most
effective SSL certificate available today. SSL certificates can be purchased
for a term of up to 3 years for further discount.






          

      

      

    

  

    
      
          
            
  
AutoInstall SSL (cPanel) Auto Update Guide

To use the Auto Update function with our AutoInstall SSL™ plugin, first you
need to setup a cron job using the Command prompt (we recommended running the
cronjob weekly).

How do I Add/Edit the Crontab?


	Login to server using Putty




To add or update the cronjob in the crontab, use the below command. It will
open the crontab file in editor where the cronjob can be added/updated.

crontab –e





[image: ../../_images/putty.png]
MAILTO=youremail@yourdomain.com
* * * * * php -q /usr/local/cpanel/base/frontend/$theme/
                                              autoinstallssl/autoupdate.php





MAILTO: the cron job email will be sent to this email address. Replace with
your email.
$theme: Please replace $theme with the theme name that you are using. It
can be x3 or paper_lantern.

*****: Please replace asterisk with Minute (0-59) / Hour (0-23) / Day of Month
(1-31) / Month of Year (1-12) / Day of Week (0-7) 0,7 are Sunday.

[image: ../../_images/cron_time.png]
Success and error messages (you will receive messages on the specified email
address as listed below):


	Successful update:
“Plugin version successfully updated from 3.0 to 3.1 for CentOS 6.6, PHP 5.4
and WHM 11.48.”


	If there is no record found:
“No record found! For the current Plugin Version 3.1, CentOS 6.6, PHP 5.4 and
WHM 11.48.”


	If there is major version:
“This is the major version of the plugin, you need to update manually! For
the current Plugin Version 3.1, CentOS 6.6, PHP 5.4 and WHM 11.48.”


	IonCube Loader error on WHM:
“Site error: the file
/usr/local/cpanel/base/frontend/x3/autoinstallssl/autoupdate.php
requires the ionCube PHP Loader ioncube_loader_lin_5.4.so to be installed by
the website operator. If you are the website operator please use the
ionCube Loader [http://www.ioncube.com/loaders.php] Wizard to assist with
installation.”









          

      

      

    

  

    
      
          
            
  
VPN


Contents:


	VPN Install On Windows 8.1

	How do I connect to my other servers using the private interface?









          

      

      

    

  

    
      
          
            
  
VPN Install On Windows 8.1

This howto will assist you with installing OpenVPN to access services on the
Limestone Private Network

For example, services available on the private network include: The private
interfaces [http://limestonenetworks-knowledge-base.readthedocs.io/en/latest/limestone_addon_services/vpn/limestone_private_tunnel.html]
on your servers,
Shared NAS Drives [http://limestonenetworks-knowledge-base.readthedocs.io/en/latest/limestone_addon_services/nas/setup_nas_acc.html],
and
IPMI devices [http://limestonenetworks-knowledge-base.readthedocs.io/en/latest/limestone_addon_services/kvmoip/access_server_ipmi.html]
for your servers.


	Download and launch the OpenVPN installer for your OS from OpenVPN’s
website [https://openvpn.net/index.php/open-source/downloads.html].




[image: ../../_images/vpn001.png]
[image: ../../_images/vpn002.png]

	Click through the installer menus to install OpenVPN.




[image: ../../_images/vpn003.png]

	Install the TAP driver when prompted.




[image: ../../_images/vpn004.png]
[image: ../../_images/vpn005.png]


4. At this point OpenVPN is installed and you should REBOOT before
continuing the installation process. The reboot is necessary because we
typically do not see the tunnel network interface registered until a reboot
occurs.

5. Download the Limestone Private Network OpenVPN configuration files from your
OnePortal account’s VPN page [https://one.limestonenetworks.com/servers/vpn.html].

[image: ../../_images/vpn006.png]
6. Copy the VPN configuration files from your downloads folder to
C:Program FilesOpenVPNconfig.

[image: ../../_images/vpn007.png]
[image: ../../_images/vpn008.png]

	Approve the file copy operation.




[image: ../../_images/vpn009.png]
8. Right click the OpenVPN GUI shortcut on your desktop and access the
Properties menu.

[image: ../../_images/vpn012.png]
9. Select the Compatibility tab, and check “Run this program as an
administrator”. Then click OK.

[image: ../../_images/vpn013.png]
10. Launch the OpenVPN GUI app from the desktop shortcut, then find the OpenVPN
GUI icon in your taskbar. Right click it to display the installed Limestone
profiles, and connect to one.

[image: ../../_images/vpn014.png]
We recommend using the UDP profile for the best performance. A TCP profile is
also provided in case you are on a restrictive, firewalled network that will
not permit the UDP profile. The TCP profile is more reliable in these cases
however it will not be as fast as the UDP tunnel.


	Use your OnePortal credentials to log in to the VPN.




[image: ../../_images/vpn015.png]
12. You are now connected to the VPN and can access IPMI cards and other
private network services.

[image: ../../_images/vpn016.png]





          

      

      

    

  

    
      
          
            
  
How do I connect to my other servers using the private interface?

Limestone Private Tunnel

Limestone keeps you connected in two different ways. Every server has two
Ethernet cards in it. The first links the server to the outside world via our
internet carriers. The second Ethernet card links the server into a back-end
router we have on our network, a LAN type of setup.

The advantage is that if a customer has more than one server, using one as,
say, a database server and the other as a traditional web server, they can
transfer information between the two servers without sending any information
out over the net. This configuration offers our clients a secure back-end
network over which they can transfer and communicate between servers without
wasting any of their bandwidth and without risking exposure of sensitive data
to the Internet.

When traffic is configured correctly, this traffic is un-metered and doesn’t
cost you any money. If you need assistance with this configuration, please open
a support ticket.

Please note:

In order for your server to communicate with the Limestone Private Tunnel, it
needs to be configured with static network routes.

For CentOS-based servers provisioned recently, we automatically add the correct
routes to a file called /etc/sysconfig/network-scripts/route-ethX (where ethX
is the private interface). If you have CentOS and the routes are not working
correctly, please open a
support ticket [https://one.limestonenetworks.com/support/newticket.html].

Also keep in mind, if your route table is filled with extraneous routes,
especially if any of them have anything to do with your private interface or
the 10.x.x.x network, this may cause issues. For this reason, if you plan to
utilize your own private network (either for VPSes or anything else), try to
utilize either the 172.16.0.0/12 range, or the 192.168.0.0/16 range.

More information is available about private IP address ranges
here [https://en.wikipedia.org/wiki/Private_network#Reserved_private_IPv4_address_space].

Making it work

Windows

route -p ADD 10.0.0.0 MASK 255.0.0.0 [privategateway]





Replace [privategateway] with the gateway from your private block of IPs.

For example: if your private block is 10.5.21.108/30, then your gateway will
be 10.5.21.109, and your usable IP (the IP you’ll use to actually contact the
server) is 10.5.21.110.

Ex:  route -p ADD 10.0.0.0 MASK 255.0.0.0 10.5.21.109

Linux

ip route add 10.0.0.0/8 via [privategateway]





or, sometimes a Linux system won’t have the ‘iproute2’ package, so use:

route add -net 10.0.0.0 netmask 255.0.0.0 dev [privateifc]





Replace [privategateway] with the gateway from your private block of IPs.

For example: if your private block is 10.5.21.108/30, then your gateway will be
10.5.21.109, and your usable IP (the IP you’ll use to actually contact the
server) is 10.5.21.110.

Replace [privateifc] with the network interface in your system that contains
your private IPs.

To find which interface is your private, type the following command in Linux:

route | grep -v "74.63" | grep -v "69.162" | grep -v "216.245" | grep -m 1
"255.255" | awk '{ print $8 }'





It will usually return either “eth0” or “eth1”. This will be your private
interface.

Please note: Static routes created in this manner are not permanent and
will be lost after reboot. To make the route persistent please see this article
under the heading “Linux Persistence Routes [https://www.cyberciti.biz/tips/configuring-static-routes-in-debian-or-red-hat-linux-systems.html]
“.
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Do you offer Data Recovery?

We partner with Flashback Data [https://www.flashbackdata.com/]
which is an approved data recovery facility for Western Digital.
They are one of the cheapest out there that also provide a no-data,
no-charge guarantee.

How much does it cost?

The cost of recovery is $300-$5000 depending on how damaged the drive is.

No-Data, No-Charge Guarantee

If they are unable to retrieve your data then your only cost is the shipping.

What are the steps for recovery?


	You contact Flashback Data at 1-866-786-5700 and get a quote based on the
speed of service you are wanting.


	You let us know you are interested in the recovery and accept financial
responsibility


	An invoice is created for shipping the drive:






	1st Overnight – $63.00


	Priority Overnight – $33.00


	Standard Overnight – $27.87


	2nd Day – $15.47







We will ship the drive and follow up with Flashback Data [https://www.flashbackdata.com/]
regarding the recovery until the data is retrieved or the drive is
found to be non-recoverable.






          

      

      

    

  

    
      
          
            
  
Believe there is a hardware issue?

We offer extensive hardware diagnostics.
If you would like us to run hardware diagnostics on your server,
here is a complete list of the work that we do:


	Check operational temperatures and insure that CPU is not going
above 65 degrees celsius.


	Ensure BIOS is up to date and the correct CMOS settings are set.


	Make sure the system boots in a timely manner and does not hang.


	Replace memory modules with known good modules. We do this instead
of testing first to save you downtime.


	
	Run the Western Digital diagnostics on the hard drive.

	
	You can choose for us to run a Quick Test which will only take
around 30 minutes or an Extended Test (which is more accurate)
which can take up to 3 hours.










	Check the case for proper cable management and optimized airflow.


	Replace internal cables (SATA, Molex Power)


	Make sure components (Heat-sink, CPU, RAM, NIC) are properly seated.


	Check the integrity of both the private and public network cables both
visually to insure a good crimp and with a cable tester to insure
connectivity on all strands.




If you would like us to perform a hardware diagnostic, please let us
know which of the tests you would like us to run:


	Quick Diagnostics – maximum of 1 hour of downtime


	Extended Diagnostics – maximum of 5 hours of downtime









          

      

      

    

  

    
      
          
            
  
Do I need to create an account before ordering?

No, if you do not already have an account you will have the chance to make
one during the ordering process. The ordering process is quick and simple.






          

      

      

    

  

    
      
          
            
  
How can I pay with American Express?

Limestone Networks does not directly accept American Express,
however you may still choose to use American Express through PayPal.
A PayPal account is not required in order to use this method.

Here is how to set up your PayPal billing source:


	Login to our control panel and go to the Billing Sources [https://rw.limestonenetworks.com/billing/sources.html] page.


	Click the “Add a Source” link.


	For “Payment Type”, choose “PayPal”.


	If you have a PayPal account, put that email address into the
“PayPal Email” field. If you do not have a PayPal account,
put your standard email address.


	Press “Add Source”.




Now you have the billing source set up.
You can choose it as a payment option when either paying an invoice
or prepaying your account.

After being transferred to PayPal, if you do not have a PayPal account
you may enter your credit card information in the form provided.
You may have to select “I don’t have a PayPal Account” in order for
the form to show.

If you have any further questions, please let us know.






          

      

      

    

  

    
      
          
            
  
Can I run my own Minecraft Server at Limestone?

You sure can! Minecraft has a beta dedicated server [https://www.limestonenetworks.com/dedicated-servers/bare-metal.html]
available on their site [https://minecraft.net/en-us/download/]
which you can use to run your own Minecraft server.

Simply check out our Game Hosting [https://www.limestonenetworks.com/solutions/game-servers.html]
solutions to get started. We would recommend no less than a
4 (quad) core server for this. Additionally, the more RAM you put in the
server will determine how large your Minecraft environment can be.






          

      

      

    

  

    
      
          
            
  
How do I upgrade RAM? [dedicated server]

To upgrade the RAM for your dedicated server [https://www.limestonenetworks.com/dedicated-servers/bare-metal.html]
, please use the following steps:


	Login to our control Panel and open a ticket for Accounting / Sales [https://one.limestonenetworks.com/support/newticket.html?probcat=accounting].


	Under the “Problem Type” box, select “Upgrade Request.”


	Under the “Server” box, select the server you want to upgrade.


	Fill in the Summary and Full Description of your request in the
appropriate boxes. If applicable, please mention any promotional
offers here.


	Click the “Submit Ticket” button on the right.




After the ticket has been submitted, a sales representative will then contact
you in the ticket and request confirmation of the upgrade with the provided
price of the upgrade. Once confirmation is met,
a pro-rated invoice will be created for the upgrade to be made.

After payment is made, the ticket will then be sent to the Support team to
schedule the upgrade for a time that best fits both the client and the
Support team.
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	How do I set Primary IP of my server?

	How can I restart my server remotely?

	Automatic OS Reloads

	How do I purchase additional IP addresses?
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API Usage and Methods  Most Helpful Article

API Usage

All customers can use POST or GET to obtain or send data to our API. In
addition, any customer that chooses to use the API must add the IP address of
the system attempting to access the API in the Control Panel -> Administrative
-> API portion of their control panel. After adding an IP to the list of
authorized hosts in your API control panel you will see the API key next to
the IP address in the list. This API key is specific to this IP address and
your server control panel account.

You MUST edit the privileges of the newly added IP if you want it to be able to
access the API’s methods.

The base URL is:

https://one.limestonenetworks.com/webservices/clientapi.php?key=YOURAPIKEY





An example would be:

https://one.limestonenetworks.com/webservices/clientapi.php?key=YOURAPIKEY&mod=billing&action=getbalance





The request above from an authorized host would return your account’s current
balance.

Returned Data Samples

Data returned from the API is in basic XML format. The following are examples
of the data returned for each of the methods and their respective actions.

Billing

The ‘getbalance’ action will return your client ID and account balance, the
value expressed is USD.

<source lang="xml">
    <client id="2XXX">
        <balance>0.00</balance>
    </client>
</source>





The ‘history’ action will return a list of invoices. Each invoice includes the
date of invoice, due date, short description, status, and list of payments
pertaining to each invoice. A paid invoice will have an
invoices->invoice->status of completed.

<invoices>
  <invoice id="1XXX1">
    <type>Debit</type>
    <created>2008-12-17 15:04:44</created>
    <unix_created>1229547884</unix_created>
    <duedate>0000-00-00</duedate>
    <unix_duedate>0</unix_duedate>
    <forserver>LSN-D0000</forserver>
    <description>New Server Order</description>
    <amount>136.74</amount>
    <status>completed</status>
    <payments>
      <payment id="1XXXX2">
        <method>PayPal</method>
        <txnid>9SA0000000000000X</txnid>
        <amount>136.74</amount>
      </payment>
     </payments>
  </invoice>
</invoices>





Servers

The ‘list’ action will return the list of servers available in the control
panel. The list includes each server’s ID, display name, public/private ips,
power/port status, and bandwidth usage.

<servers>
 <server id="LSN-D0000">
   <displayname>ServerName</displayname>
   <publicip>74.63.000.000</publicip>
   <privateip>10.2.000.000</privateip>
   <powerstatus>on</powerstatus>
   <bandwidth>
     <actual>
       <percentage>9.62</percentage>
       <bytes>192479575610</bytes>
       <friendly>192.5GB</friendly>
       <allocated>2000GB</allocated>
     </actual>
     <predicted>
       <percentage>70.87</percentage>
       <bytes>1417495092920</bytes>
       <friendly>1.4TB</friendly>
     </predicted>
   </bandwidth>
   <portstatus>
     <public>on</public>
     <private>on</private>
   </portstatus>
 </server>
</servers>





Code Samples

The following are some simple examples of how to query data from the API.

Simple PHP Example

The following example requires the simplexml_load_file function which is
included with PHP5 but not PHP4.

$apiKeyList = array(
   "exampleapikeynumber1",
   "exampleapikeynumber2"
)

foreach ($apiKeyList as $apiKey) {
   $apiData = "https://one.limestonenetworks.com/webservices/clientapi.php?key=".$apiKey."&mod=servers&action=list"

   $serverList = simplexml_load_file($apiData)

   foreach ($serverList->server as $serverItem) {
       print "<ul>"
       ."<li>Server ID = {$serverItem->attributes()->id}"
       ."<li>Server Name = {$serverItem->displayname}"
       ."<li>Server Public IP = {$serverItem->publicip}"
       ."<li>Server Bandwidth Used = {$serverItem->bandwidth->actual->friendly}"
       ."</ul>"
    }
}

unset($apiKey);










          

      

      

    

  

    
      
          
            
  
WHMCS Server Module for OnePortal

To easily resell our services to your clients Install our OnePortal plugin [https://github.com/limestonenetworks/oneportal-whmcs]

Installation

Dedicated servers: Move/Upload all of the files in the oneportal folder to
modules/servers/oneportal Cloud servers: Move/Upload all of the files in the
oneportalcloud folder to modules/servers/oneportalcloud

Dedicated Servers Setup

For every hosting product/service while you set them up:


	Go to the Module Settings tab


	Select Oneportal as the Module Name


	Input your API Key from OnePortal’s Administrative -> API


	Check any options you’d like


	Change the rDNS Domain to your domain name


	Leave the option as Do not automatically setup this product




Then, go to the Custom Fields and add a field with the following:


	Field Name: Server ID


	Field Type: Text Box


	(optionally) Description: Unique Server ID within the data center


	(optionally) Click Admin Only if you don’t want to show this information
to the client


	(optionally) Click “Show on invoice” if you want the Server ID on your
clients’ invoices




Then, when you provision a new server for a client:


	Modify the product through the client’s Products/Services tab


	Locate the Server ID field and put in the server’s ID as either
D#### or LSN-D#### where the # signs are the ID of your server in
OnePortal


	Click Save Changes


	After the server is provisioned in the data center more information will be
available in the Bandwidth, Hardware and IP Addresses sections
of the product




Bandwidth Statistics (optional, may not work due to WHMCS limitations)

To update bandwidth usage, you should setup a cron job for the following:

php -q /full_path_to/whmcs/modules/servers/oneportal/usageupdate.cron.php





We recommend every 5 minutes. If you use this feature, be sure to put your API
key on line 4 of usageupdate.cron.php where you see “$oneportal_api_key =”

Cloud Servers Setup

For every hosting product/service while you set them up:


	Create a new Oneportal user to be used with the API. USERNAME-api or
something similar.


	Give your new user the privileges you desire. It will need most of them in
order for this module to function properly. For a quick start just check
all.


	Open WHMCS and go to the Module Settings tab


	Select Oneportalcloud as the “Module Name”


	Input your Oneportal api user and password. This user must have the correct
privileges set from within Oneportal.


	Check any options you’d like


	The options for Ram/Storage/OS/Cores serve as the default for any cloud
server you provision. This gives you the ability to either create multiple
products with a set configuration or you can create configurable options for
these fields. Scalability will not be possible without configurable options
being setup.


	Change the rDNS Domain to your domain name


	When the product is activated it will create the server and set the Server
ID (explained below) for you.




Then, go to the Custom Fields and add a field with the following:


	Field Name: Server ID


	Field Type: Text Box


	(optionally) Description: Unique Server ID within the data center


	(optionally) Click Admin Only if you don’t want to show this information
to the client


	(optionally) Click Show on invoice if you want the Server ID on your
clients’ invoices




Setting up configurable options

If you wish to have scalable cloud servers and/or give your users the ability
to choose the configuration options of their cloud server then follow the
instructions here.


	Go to Setup -> Products/Services -> Configurable Options


	Create a new group


	Click the edit group button


	Click add new configurable option


	From this screen you can add the options that you wish


	The option names are case sensitive and must be one of the following: Ram,
Storage, Cores, OS, IPs


	The option name that is visible on the order form can be customized by using
the | character. Example: IPs|IP Addresses


	Choose type of dropdown and add an entry for each option you want to be
available. The accepted options for each type are listed below.


	The input is expected to be one from this list. If it is not then it will
result in the server being unable to provision.




Option parameters

Ram => 512MB,1GB,2GB,4GB,8GB,16GB,32GB

Storage => 5GB,10GB,15GB,20GB,50GB,100GB,120GB,140GB,160GB,180GB,200GB

Cores => 1,2,3,4,5,6,7,8,9,10,11,12

OS => CentOS 5.9 x64,CentOS 6.4 x64,Debian 7.0 x64,Fedora 18 x64,
Red Hat Enterprise Linux 5.9 x64,Red Hat Enterprise Linux 6.4 x64,
Arch Linux 2012.12 x64,CloudLinux Server 6.4 x64,openSUSE 12.1 x86,
PBXware 3.1 x86,Scientific Linux 6.2 x64, Slackware 13.37 x64,
Windows 2012 Standard Edition R2 – 64 bit

IPs => 1 IP, 2 IPs, 3 IPs, 4 IPs, 5 IPs

Control Panel => None, cPanel


	Note about control panel: If centos 5/6 or cloud linux is chosen for the
operating system then cpanel will be preinstalled and a license issued. If
another operating system is chosen then it will not be preinstalled but a
license will still be issued.









          

      

      

    

  

    
      
          
            
  
How do I set Primary IP of my server?

When you have multiple blocks, its hard for our Support Techs to determine
which IP is your primary. Additionally it can become confusing for you
everywhere we display your server’s IP address if it is not correctly set to
your primary IP address.

You may now define your primary IP address by doing the following:


	Login to our control panel


	Go to the Servers tab


	Click Edit Name/IP next to the server you’d like to change the Primary IP on


	Choose your new Primary IP at the bottom of the page


	Press the Update Primary IP button at the bottom









          

      

      

    

  

    
      
          
            
  
How can I restart my server remotely?

There are many ways to restart your server remotely without having to contact
our Support team.

If you have access to your server…

Restart your server through SSH (Linux)

Connect to your server through SSH and run either of these commands:


	shutdown -r now


	reboot


	init 6




Restart your server through RDP (Windows)

After connecting to your Windows server using Remote Desktop, use the start
button to initiate a restart.

If you cannot access your server…
Use the IPMI Interface

Most of our dedicated servers come with a remote management interface. From
OnePortal, simply click the black console icon next to your server’s name. You
can then login using your OnePortal login.

Restart through OnePortal

As a last resort, you can restart your server through OnePortal by clicking on
your server’s name and clicking the Power button.






          

      

      

    

  

    
      
          
            
  
Automatic OS Reloads

Limestone Networks has given you the ability to reload your dedicated server [https://www.limestonenetworks.com/dedicated-servers/bare-metal.html] at any
time through your control panel. This service is absolutely free and requires
little to no tech interaction.

Changing your Control Panel

If you’d like to change the control panel installed on your server, you must
contact our Sales or Support department before starting your reload. If you
don’t, your server will automatically reinstall the control panel previously
installed.

Perform the Reload


	Click on the servers tab


	In the details area click on the OS Reload tab


	On the “Operating System Reload” page click Reload on the right hand side


	Use the provided password or enter and confirm your own


	Check the box at the bottom of the form declaring you would like all data
erased and the OS reinstalled


	Click Start Reload




NOTE: If Auto OS Reload is unavailable then the column will read “Contact
Support” and provide you with a link to instantly open a ticket.






          

      

      

    

  

    
      
          
            
  
How do I purchase additional IP addresses?

We have made it possible for you to add IPs to your server instantly through
our control panel.

Here’s how you can do it:



	Login to our control panel


	Click on the Servers tab


	Click Edit Name/IP next to your server


	Locate Purchase more IP Addresses


	Select the amount of IP Addresses you would like to purchase


	Press the Purchase using Account Credit button







You must have Account Credit in order to use this feature. You can prepay your
account by visiting the Billing -> Prepay screen.

If you have any further questions, please let us know.






          

      

      

    

  

    
      
          
            
  
Can I set rDNS through the API?

Yes, you may. Our API supports a method called setreverse which allows you to set your Reverse DNS per IP Address. See the API documentation [http://limestonenetworks-knowledge-base.readthedocs.io/en/latest/oneportal/api_usage_and_methods.html] for more information.






          

      

      

    

  

    
      
          
            
  
How long will it take to reload / set up my new server?

Limestone is known for its extremely quick provisioning times.

Our normal provisioning time is 1-4 hours, however, in some cases,
our provisioning time may be longer. We appreciate your patience
and we will have your server online as soon as possible.

Please note: Custom partitioning will require extra time to
provision your server (up to 24 hours).

Our current record for the fastest provision is 16 minutes.
This includes formatting, operating system installation,
and configuration.






          

      

      

    

  

    
      
          
            
  
Operating System Support


Contents:


	Linux Support
	Receiving an “ip_conntrack: table full” error.

	Hardening CentOS

	How do I set up the local yum repo?

	How can I reset my root password?

	How do I schedule FSCK to run automatically?

	How do I set up SSH key authentication?

	How do I use iptables?

	Large file transfer gives error: Corrupted MAC on input

	How do I run a ping?

	How do I run a traceroute?

	How do I bind my additional IPs?

	Do you support my Custom Operating System install?





	Windows Support
	How do I set additional IPs in Windows?

	How do I disable Internet Explorer Enhanced Security?

	How do I enable ICMP echos in Server 2008?

	IPMI issues with Java 8

	Terminal Server Has Exceeded Max Connections

	Windows Memory Limits

	Windows VPS Licensing

	How do I configure the Windows Firewall?

	How do I block a specific IP from my server?

	Drives not appearing in Windows 2008 installer.













          

      

      

    

  

    
      
          
            
  
Linux Support


Contents:


	Receiving an “ip_conntrack: table full” error.

	Hardening CentOS

	How do I set up the local yum repo?

	How can I reset my root password?

	How do I schedule FSCK to run automatically?

	How do I set up SSH key authentication?

	How do I use iptables?

	Large file transfer gives error: Corrupted MAC on input

	How do I run a ping?

	How do I run a traceroute?

	How do I bind my additional IPs?

	Do you support my Custom Operating System install?









          

      

      

    

  

    
      
          
            
  
Receiving an “ip_conntrack: table full” error.

On OpenVZ/HyperVM machines sometimes the ip_conntrack table will become full
and drop packets. You can tell if it is doing this by looking in your
/var/log/messages file.

To find out the current limit run:

sysctl net.ipv4.netfilter.ip_conntrack_max





Then to increase it edit:

/etc/sysctl.conf





and change the line:

net.ipv4.netfilter.ip_conntrack_max = to a higher number





Adding 5000 or 10000 to the current max should be fine.

Once you have saved the file, to reload the new configuration run:

sysctl -p





You should be all set and the machine should not be dropping any packets.






          

      

      

    

  

    
      
          
            
  
Hardening CentOS

What will this script do?


	Install useful packages such as tcpdump, mtr, zsh, perl and logrotate


	Setup automatic yum updates


	
	Set password policies

	
	Passwords will expire every 180 days


	Passwords may only be changed once a day










	
	Set OS policies

	
	Set idle users to be disconnected after 15 minutes










	
	Install (if it is not installed) and configure IPTables firewall

	
	Open specified TCP/UDP ports


	
	Set rules to block common attacks

	
	Syn Floods


	Fragmented Packets


	Malformed XMAS Packets


	Drop NULL packets


	Limit pings to 3 per second and bursts of 25


	Discourage Port Scanning










	Set up Connection Tracking










	
	Install DDoS Deflate

	
	More information about DDoS Deflate is available at
https://www.interserver.net/tips/kb/installing-configuring-linux-ddos-deflate/










	
	Install CHKROOTKIT

	
	Scheduled to check daily for issues and email your Admin Email


	
	More information about CHKROOTKIT is available at

	http://www.chkrootkit.org/















	
	Install rkhunter (Root Kit Hunter)

	
	Scheduled to check daily for issues and email your Admin Email


	More information about rkhunter is available at
http://www.rootkit.nl/projects/rootkit_hunter.html










	
	Install LSM (Linux Socket Monitor)

	
	Runs in the background and watches for changes in sockets










	
	Secure the SSH Daemon

	
	Change the SSH port to a random number


	Create an “admin” user


	Make it so only the “admin” user can be logged into over SSH












Downloading the Script:

cd /root
wget http://mirror.lstn.net/scripts/hardening/centos.sh
chmod +x centos.sh





Modifying the Variables:

vim centos.sh





You may customize TCPPORTS and UDPPORTS, however
the defaults in there now should cover most common processes.

Run the Script:

./centos.sh





What to do afterwards

After it completes, you will get a message like:

******************************************
YOUR SERVER IS NOW HARDENED
------------------------------------------
SSH User: admin
SSH Pass: 254457cb9448226
SSH Port: 5575
Admin Email: admin@fake.lstn.net
******************************************

You must now reconnect to this server using the information above
Changing the SSH port has caused this connection to freeze.
BEFORE CLOSING THIS WINDOW please note your information above.










          

      

      

    

  

    
      
          
            
  
How do I set up the local yum repo?

You may now get your CentOS installs and updates locally on Limestone’s
network. When routed correctly, it will not count against your monthly
bandwidth.

Yum Configuration

Edit the config:

vi /etc/yum.repos.d/CentOS-Base.repo





And put the following:

[base]
name=CentOS-$releasever - Base
baseurl=http://centos.mirror.cust.lstn.net/$releasever/os/$basearch/
gpgcheck=1
gpgkey=http://mirror.centos.org/centos/RPM-GPG-KEY-CentOS-5

[update]
name=CentOS-$releasever - Updates
baseurl=http://centos.mirror.cust.lstn.net/$releasever/updates/$basearch/
gpgcheck=1
gpgkey=http://mirror.centos.org/centos/RPM-GPG-KEY-CentOS-5

[addons]
name=CentOS-$releasever - Addons
baseurl=http://centos.mirror.cust.lstn.net/$releasever/addons/$basearch/
gpgcheck=1
gpgkey=http://mirror.centos.org/centos/RPM-GPG-KEY-CentOS-5

[extras]
name=CentOS-$releasever - Extras
baseurl=http://centos.mirror.cust.lstn.net/$releasever/extras/$basearch/
gpgcheck=1
gpgkey=http://mirror.centos.org/centos/RPM-GPG-KEY-CentOS-5

[centosplus]
name=CentOS-$releasever - Plus
baseurl=http://centos.mirror.cust.lstn.net/$releasever/centosplus/$basearch/
gpgcheck=1
gpgkey=http://mirror.centos.org/centos/RPM-GPG-KEY-CentOS-5





Correctly Route the Traffic

ip route add 10.0.0.0/8 via <private-gateway-ip> dev <private-interface>





If you want this to save after reboot, add to
/etc/sysconfig/network-scripts/route-private-device

10.0.0.0/8 dev <strong>private-interface</strong>





Example:

10.0.0.0/8 dev eth1










          

      

      

    

  

    
      
          
            
  
How can I reset my root password?

This article explains how to reset the root password if you no longer know it.
You will require KVM access to your server in order to perform these steps.

CentOS/Fedora


	Through the KVM, initiate a restart of your server by sending the shutdown
command




shutdown -r now






	When it comes to the Loading CentOS/Fedora Grub Bootloader screen hit
esc.(Right after you get to the network boot screen it will be at the
grub bootloader screen)


	At the grub screen select the default OS & hit e to edit.


	Then you should have 3 lines of text. Select the line that starts with
kernel & ends in root=label=/


	Press e to edit the line, and at the end of the line add a space and then
put a capital S.


	Then enter to save & go back to the previous screen.


	Then hit b for boot with that line selected.


	It will enter you in single user mode and you get a bash prompt.


	Then you can just type passwd enter new password and reboot.




You will not need to re-edit the grub loader it reverts to normal after the
next reboot.

Debian

Reboot and edit the Grub kernel line add a space then the following at the end
of the line. (like ‘Alternate Method’ above)

init=/bin/sh





Then run this command to remount the root partition in read/write mode.

mount -o remount,rw /





and reset the root password as normal with the passwd command.






          

      

      

    

  

    
      
          
            
  
How do I schedule FSCK to run automatically?

Using cron to schedule an FSCK


	By default, a fsck is forced after 30 reboots or 180 days.


	To avoid issues such as this, we recommend scheduling fsck to run a basic
weekly check on your server to identify and flag errors.
- Doing so can prevent unwanted, forced fsck from running in situations such
as this one.
- You can then, plan for a time at which a full system fsck is run.




For more info on running fsck please click here [https://en.wikipedia.org/wiki/Fsck]
For more info on scheduling tasks under Linux click check [https://en.wikipedia.org/wiki/Cron]

The following example syntax will add a weekly scheduled scan-only fsck and
output the results to a log file for review.

crontab -e





enter the following text substituting partition with your root partition.

@weekly fsck -nv /dev/*partition* > /var/log/weekly_fsck





When saving, do not change the existing file name.

PLEASE NOTE–

This does not eliminate the need for a fsck.
You will still need to schedule a manual fsck.

To Force a fsck using shutdown command

shutdown -rF now





Bypass a fsck using shutdown command

shutdown -rf now





Note: Capital F will Force a FSCK, lowercase f skips a FSCK.

FSCK will sometimes require the root password be entered on the console in
order to repair some issues with the filesystem, contact our support department
if your server does not respond after a reboot.






          

      

      

    

  

    
      
          
            
  
How do I set up SSH key authentication?

SSH packets being sent from the SSH client to the server are encrypted with a
form of shared-key cryptography, using a random key which is generated for each
new connection and thrown away when that connection is over. The client and the
server use public-key cryptography to agree on the session key, and either
party may request a re-keying of the session at any time.

Once you become familiar with SSH keys, communication and file copying between
servers / clients will be secure, quicker, and more convenient.

Here’s an example on setting it up between a CentOS Client and CentOS Server:

On the client, do the following:


	Goto the .ssh directory, which is located under /root – full path is
/root/.ssh


	Now let’s create our private and public keys and put them into a file.




ssh-keygen -t rsa





This created a 1024 bit key, and creates 2 files.


	id_rsa – This holds your client’s PRIVATE Key.


	id_rsa.pub – This holds your server’s PUBLIC key.




Now, let’s place the key id_rsa.pub into the servers authorized_keys file.
Located at: /root/.ssh/authorized_keys, If this file is not already there,
we will create it.

Next you need to copy the key to your system. We’ll copy the key over via a
file copying program called rsync

rsync -av -e ssh id_rsa.pub <SERVER_IP>:/root/.ssh/





Make sure to change SERVER_IP to the servers IP address.

After doing this command, you will be prompted for the root password of the
server, type it and press enter.

Now, on the server, do the following:

cd /root/.ssh
cat id_rsa.pub >> authorized_keys
chmod 600 authorized_hosts





The 2nd command copies the contents of id_rsa.pub into authorized_keys file.

The 3rd command gives it the correct permissions to be run by the system.

Now, back on the client, do the following:

cd /root/.ssh
eval `ssh-agent`
ssh-add id_rsa
ssh-add -l





2nd command: Starts the SSH agent program.

3rd and 4th command: Adds your private key into memory.

Simply SSH into the server.

ssh <server_IP>





When prompted, type in the root password. Now exit out and try to SSH into the
server from the client once more. This time – you shouldn’t be prompted for a
password.






          

      

      

    

  

    
      
          
            
  
How do I use iptables?

Warning

Modifying rules on your server can cause the server to become inaccessible on
port 22 (SSH) or your alternate SSH port.

Description / Basic Overview

Everyone in the IT industry is very concerned with security, especially if
you’re a linux administrator. Many linux distributions come with several
services that you may not use or ever need but they’re running on your server
anyway. This can cause many security threats. With the slightest knowledge of
Linux firewalls (iptables) you can secure your linux server very quickly and
efficiently. In this article, I will either introduce you into iptables for
your first time, or help you become more efficient with iptables if you’ve
worked with them in the past.

As network packets flow in and out of the network interface card, they are
intercepted, analyzed and manipulated as ruled through the Linux firewall. As
the packet flows through the firewall rules and it reaches a rule that is
matches, it stops there and doesn’t continue through the rest of the rule set.
For instance, if there is a rule to drop all packets coming in through port 25
and then a rule directly after that says “accept 192.168.1.25 on port 25” That
packet will be dropped once it hits the first rule. It won’t even know there is
a second rule. Read the first example further down this article. There is an
example. There have been 3 main linux firewalls widely used, and they are as
follows:

History


	Ipfwadm which was merged into Linux 2.0. It can filter TCP, UDP, and ICMP
packets only. It also does not support QoS. You can “insert” and “remove”
rules. This doesn’t make it the most user friendly linux firewall on the
planet.


	Ipchains which was merged into Linux 2.2. It supports QoS, Is very flexible
with the configuration, as it has “replace” along with “insert” and “remove”.
This makes ipchains more user friendly. Ipchains also has the ability to
filter any IP protocol explicitly, not just TCP, UDP, and ICMP.


	Iptables. This iptables project was begun in 1998 by Rusty Russell. This was
merged into Linux 2.3 in 2000, and is still widely used today. It supports
stateful IPv4, and IPv6 protocol tracking and IPv4 application tracking. Has
built-in PORTFW functionality. It is also very user friendly, as you’ll soon
find out.




Getting started

Let’s take a look at our iptables list, see what is currently under there!

/sbin/iptables -L -n





That will show you your complete iptables rule list, with as much information
as possible about each rule. Let’s break down what you’re looking at you should
see something similar to: (note: the following is an empty table you may have
some rules in yours).

Chain INPUT (policy ACCEPT)
target         prot            opt             source               destination

Chain FORWARD (policy ACCEPT)
target         prot            opt             source               destination

Chain OUTPUT (policy ACCEPT)
target         prot            opt             source               destination





Flushing your list of rules can be good if you would like to rewrite your rules
completely as I’ve done plenty of times in the past. You can “flush” every rule
under iptables by doing

/sbin/iptables -F





However you may want to only flush all the rules under the INPUT, FORWARD or
OUTPUT chain. You can specify which chain to flush by either of the following:


	/sbin/iptables -F INPUT


	/sbin/iptables -F FORWARD


	/sbin/iptables -F OUTPUT




Additionally, you can save your rules so that when you restart your linux
server, the current rules will become active once again. You can save by doing

/etc/init.d/iptables save





If you would wish for iptables to STOP running, you can initiate the following
command

#> /etc/init.d/iptables stop

Flushing firewall rules:                                       [  OK  ]
Setting chains to policy ACCEPT: filter                    [  OK  ]
Unloading iptables modules:                                    [  OK  ]
Of course, you can START iptables by doing
/etc/init.d/iptables start
Applying iptables firewall rules:                      [  OK  ]





As for an example, I have one below:

Example

You want to simply deny every IP address a connection to your SMTP server (tcp
port 25) except for the IP: 192.168.1.25.

The two commands for this are as follows

/sbin/iptables -I INPUT -p tcp --dport 25 -j DROP
/sbin/iptables -I INPUT -s 192.168.1.25 -p tcp --dport 25 -j ACCEPT





The reason I put the “DROP” command in before the “ACCEPT” is because a rule is
entered into the database, and then a rule that is added next is added directly
above the last one entered. Putting the DROP command before the ACCEPT let’s
the ACCEPT rule be read before the DROP command. Let’s break the rest of these
commands down:

The first command:


	-I is to insert the rule into the top of the chain. You would use -A to
insert it at the bottom of the chain. (Note: you can do “–D” instead to
delete the rule from the chain as well.)


	INPUT is the chain name. Input is the chain that is followed by
“incoming” packets.


	-p is the protocol argument, you specify the protocol type with this
command, notice the “tcp” after the “-p”


	–ddport is what specifies which port to filter. In this case it is 25,
because that is what port SMTP runs on (by default).


	-j is the argument that specifies what to do with the packet. In this
case, it’s going to be “DROPPED”




The second command:

The only difference between this command and the first one, is there is a (-s)
“src” IP address specified and the –j argument is “ACCEPT”.

Since a (-s) “src” address was not specified in the first argument, it assumed
that every address is to be dropped.

Ok, let’s save our current work.

#> /etc/init.d/iptables save
/sbin/iptables -L -n
Chain INPUT (policy ACCEPT)
target     prot opt source               destination
ACCEPT          tcp  --  192.168.1.25         0.0.0.0/0           tcp dpt:25
DROP            tcp  --  0.0.0.0/0                0.0.0.0/0           tcp dpt:25





Notice: how the “ACCEPT” rule is above the “DROP” rule.






          

      

      

    

  

    
      
          
            
  
Large file transfer gives error: Corrupted MAC on input

Symptom

When you transfer a large file by HTTP it will disconnect and
give you this error:

Disconnecting: Corrupted MAC on input.

This can also happen on SSH, FTP or other protocols as this is a
bug with the kernel driver for the network.

Solution

Turn off “offload check summing” with the following command:

ethtool -K eth0 rx off tx off

Depending on the Ethernet driver in use this may not work as some
drivers do not support turning off this feature.






          

      

      

    

  

    
      
          
            
  
How do I run a ping?

PING stands for Packet INternet Groper.

This is a simple diagnostic tool implemented in both Windows and Linux
that enables you the ability to test for basic communication between two
network nodes within a LAN or across the WAN/Internet.

The concept is simple – a special packet is sent from a source machine
to a destination the machine at which the destination machine
responds back.

The time it takes for this process to complete helps determine
two things:



	Does the destination machine respond?


	How long does it take the destination machine to respond back?







To run this tool is very simple.

For windows you simply open a command prompt:


Go to Start->run->type CMD->press enter




Within the command prompt you will type:


ping destination-IP -n 10




For example:


ping 4.2.2.2 -n 10









          

      

      

    

  

    
      
          
            
  
How do I run a traceroute?

Both Windows and Linux have the ability of diagnosing the health
of a connection between a source and destination machine by also
testing the communication status of the devices that make the
connection possible.

Windows uses the command tracert for this utility.
Linux uses the command traceroute for this utility.

The route is determined by examining the ICMP Time Exceeded
messages sent back by intermediate routers. Note that some routers
silently drop packets with expired TTLs and are invisible to
TRACERT / Traceroute utilities.

How to run a traceroute

Windows


	Open a command prompt by going to Start->run->type command->press enter.


	Type the command: tracert




For example:


C:\>tracert 4.2.2.2




Linux

For linux the command would be:


traceroute <ip address>




For example:


traceroute 4.2.2.2









          

      

      

    

  

    
      
          
            
  
How do I bind my additional IPs?

These instructions are for CentOS / Fedora specifically.
By default, Limestone only binds your first primary IP address.
This is because there are different methods of applying your
additional IPs that may require that they not be bound originally.

Here is the simplest way of binding your additional IPs:


	Find out which interface is your public




[root@LSN-D#### ~]# route | grep -v "10." | grep -m 1 "255.255"
| awk '{ print $8 }'

eth1

This shows that my public interface (does not have a “10.” address)
is eth1.

2) Create the route file

Before running the command below, change “eth1” to your public
interface from step 1 and set your START and END IP addresses
in the range.

Note:
Your IPADDR_START should be your second usable IP as your primary
is already bound. The IPADDR_END value is your last usable IP.
If you are unsure what these values are
please check your welcome e-mail or open a support ticket [https://rw.limestonenetworks.com/support/newticket.html].


echo "IPADDR_START=123.123.123.4
IPADDR_END=123.123.123.5
CLONENUM_START=0" >> /etc/sysconfig/network-scripts/ifcfg-eth1-range0




3) Restart your network interface


service network restart









          

      

      

    

  

    
      
          
            
  
Do you support my Custom Operating System install?

Only operating systems listed on the Limestone order form and installed
by Limestone technicians are supported by our technical staff.
We will make a best effort attempt to support OS installs not meeting this
criteria if time permits, however in most cases customers with custom OS
installs or “Install Your Own OS” systems will be required to maintain their
own OS by means of IPMI (on applicable servers) or a KVMoIP unit which
we lease on an hourly basis.

This is not applicable to network or hardware issues, and those items will
be maintained per our normal support procedures by technical staff
regardless of OS install method.

The rates for KVMoIP are as follows:


	$5/hour (minimum of 3 hours)


	$30/day (for a 24 hour period)


	$60/month









          

      

      

    

  

    
      
          
            
  
Windows Support


Contents:


	How do I set additional IPs in Windows?

	How do I disable Internet Explorer Enhanced Security?
	For Windows 2003

	For Windows 2008 it is a little different

	For Windows 2012 it is almost like 2008





	How do I enable ICMP echos in Server 2008?

	IPMI issues with Java 8

	Terminal Server Has Exceeded Max Connections

	Windows Memory Limits

	Windows VPS Licensing
	Frequently Asked Questions (FAQ)





	How do I configure the Windows Firewall?

	How do I block a specific IP from my server?

	Drives not appearing in Windows 2008 installer.









          

      

      

    

  

    
      
          
            
  
How do I set additional IPs in Windows?

By default, Limestone only binds your first primary IP address. This is because
there are different methods of applying your additional IPs that may require
that they not be bound originally.

Basic

Here is the simplest way of binding your additional IPs:


	Login to Remote Desktop


	Go to Control Panel-> Network Connections -> Local Area Connection (make
sure that the IP on this connection is not 10.*. If it is, use the other
Local Area Connection)


	Right-click on Properties


	Select Internet Protocol (TCP/IP)


	Click Properties


	Click Advanced


	Click Add and add the new IPs with the correct Subnet Mask




Advanced

If you are adding multiple IP addresses, you can also use the following in the
command prompt.

FOR /L %I IN (x,1,y) DO netsh interface ip add address "Local Area Connection
2" 216.245.218.%I 255.255.255.224






	x = The starting octet. This should be the one after your primary. (0.0.0.x)


	y = The ending octet. Your last available IP.




You will need to change “216.245.218.” and “255.255.255.224” to match your IPs
and subnet.






          

      

      

    

  

    
      
          
            
  
How do I disable Internet Explorer Enhanced Security?


For Windows 2003

Windows Server 2003 is shipped with security locked down by default. Part of
this locking down is Internet Explorer Enhanced Security which is an extra
layer of protection when surfing the internet using Internet Explorer.

You can uninstall the entire Configuration, or just for users, or just for
Administrators.

The un-installer is set up like this:

- Enhanced Security
   - For Administrators
   - For Users





If you have non-admin users connecting via Remote Desktop or Terminal Services,
you may wish to leave the Users configuration installed. This tutorial will
remove it for all users.

Method:


	Click Start, then Control Panel, and then select Add/Remove Programs


	Click Add/Remove Windows Components




A window will pop-up, click the check mark next to Internet Explorer Enhanced
Security Configuration (to uncheck it). If you’d like to only disable it
for Administrators or for Users only you can click “Details” and change this
setting individually.

Press Next, it will take a couple of seconds to finish, and then it’s all done!




For Windows 2008 it is a little different

First, open the Server Manager by going to Start > Server Manager

In the Server Manager browse to the Security Information section in the right
hand pane and click ‘Configure IE ESC’. IE ESC is located in the very lower
right-hand corner of the window.

In the Internet Explorer Enhanced Security Configuration window decide for whom
you want IE ESC enabled or disabled and click OK.

It can be enabled/disabled for Administrators only or for all users




For Windows 2012 it is almost like 2008

On the Windows Server 2012 server desktop, locate and start the Server Manager.

Select Local Server (The server you are currently on and the one that needs IE
Enhanced Security disabled)

On the right side of the Server Manager, you will find the IE Enhanced Security
Configuration Setting. (The default is On)

You have two settings that can be disabled, one only affects the Administrators
and the other all users. Make your selection to Off for Administrators, Users
or both.








          

      

      

    

  

    
      
          
            
  
How do I enable ICMP echos in Server 2008?

To enable ICMP replies in Windows Server 2008 you must allow ICMP packets
through the windows Firewall


	Press Start


	Goto -> Administrative tools


	Click on ‘Windows Firewall with Advanced Security’


	Click on ‘Inbound Rules’


	Scroll down to find: ‘File and Printer Sharing (Echo Request – ICMPv4-In)’


	Right-click on this and choose ‘Enable Rule’




Congrats, you can now ping the 2008 server.






          

      

      

    

  

    
      
          
            
  
IPMI issues with Java 8

With the new Java 8 rolled out, it has been discovered that it can block access
to SuperMicro IPMI interfaces, if it doesn’t meet the minimum security
requirements.

Below are the steps that can be taken to fix this. This solution should work
for Windows 7 64bit, Windows 7 32bit, Windows 8 64bit, and Windows 8 32bit.
This fix may need to be implemented before each remote control session via a
SuperMicro IPMI.


	Go to the Start Menu


	Choose Java


	Click Configure Java


	You should be on the General tab


	Click Settings…


	Click Delete Files…




Make sure both “Trace and Log Files” and “Cached Applications and Applets” are
check marked and “Installed Applications and Applets” is unchecked.


	Press OK


	Click Security


	On this page, make sure that the Java security level is set to the High
setting.


	Click Edit Site List, then add the IP address of the IPMI to the
Exception Site List….


	Click Apply


	Press OK again on the General tab to exit


	Open the Remote Control session,  and you should then be able to use the
IPMI.









          

      

      

    

  

    
      
          
            
  
Terminal Server Has Exceeded Max Connections

This problem happens because Windows only allows two remote terminal services
connections to be logged in as an Administrator, and you’ve either got two
people already on that server as an Administrator, or more likely, you’ve got a
disconnected session that is still logged in (simply closing the RDP session
does not log you out, you need to log out from the Start Menu on the remote
server).

To force yourself to login as an admin (provided you have admin credentials to
log on with) execute the following from your local computer:

For users with XP SP3, Vista, or terminal services client => 6.1:


	Start > Run >




mstsc /v:0.0.0.0 /f /admin





Otherwise:


	Start > Run >




mstsc /v:0.0.0.0 /f /console





…Replace the 0.0.0.0 with your IP address, type in your username/password at
the prompt and you are good to go.

For more information on the mstsc command click here [https://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/ts_cmd_mstsc.mspx?mfr=true].

Free bonus: Need to Ctl + Alt + Del in a RDP window? Don’t work? Try Ctl + Alt
+ End instead.






          

      

      

    

  

    
      
          
            
  
Windows Memory Limits

The table below describes the psychical memory limits supported by each Windows
version. We want to make sure our clients are aware of these limits as we begin
to offer increased amounts of RAM across our server platforms.

Version                     32bit Limit        64bit Limit
Windows 2008 Standard R2      n/a               32GB
Windows 2008 Enterprise R2    n/a                2TB
Windows 2008 Datacenter R2    n/a                2TB
Windows 2012 Standard         n/a                4TB
Windows 2012 Enterprise       n/a                n/a
Windows 2012 Datacenter       n/a                4TB
Windows 2016 Standard         n/a               24TB
Windows 2016 Datacenter       n/a               24TB





We recommend that servers using more than 4GB of RAM install a 64bit operating
system over a 32bit operating system with PAE support.

microsoft_memory_limit [https://msdn.microsoft.com/en-us/library/aa366778(v=vs.85).aspx]

microsoft_PAE [https://msdn.microsoft.com/en-us/library/aa366796(v=vs.85).aspx]






          

      

      

    

  

    
      
          
            
  
Windows VPS Licensing

Some customers may be interested in Windows Virtualization but are not sure
which edition they should use. The following table outlines the number of
virtual instances allowed per edition. Activation for server 2008 virtual
machines is performed by manually by our Support Team at this time. If you are
having trouble activating the OS please open a support ticket.

Edition      VPS     Price/month       Notes
Web             0       $10.00    Web Edition does not provide virtualization support.
                                  Web Edition can be run as a virtual instance
                                  or a physical instance but not both.
Standard        1       $35.00    Standard Edition allows up to 1 virtual instance
Enterprise      4       $45.00    Enterprise Edition allows up to 4 virtual instance
Datacenter  Unlimited   $75.00    Datacenter Edition allows unlimited virtual instances
                                  as you can physically run.






Frequently Asked Questions (FAQ)


	Can I run Windows Server 2003 as one of my virtual instances?





	Yes. You may run earlier versions of the Windows Server operating system,
but not later versions, by exercising your downgrade rights in the software
license terms.





	Do the virtualization licensing rights of Windows Server 2008 apply when
used with non-Microsoft software virtualization technologies?





	Yes. The use rights apply regardless of the virtualization product being
used.





	Can I run Windows Server 2008 Standard in place of Windows Server 2008
Enterprise in the physical operating system environment?





	Yes. The use terms specify that the right to run Windows Server 2008
Standard in place of Windows Server 2008 Enterprise is allowed within any
operating system environment.











          

      

      

    

  

    
      
          
            
  
How do I configure the Windows Firewall?

Microsoft has developed a great article centered around configuration
of the Windows Firewall with Advanced Security and IPsec Policies.

This step-by-step guide illustrates how to deploy Active Directory® Group
Policy objects (GPOs) to configure Windows Firewall with Advanced Security
in Windows 7, Windows Vista, Windows Server 2008 R2, and Windows Server 2008.
Although you can configure a single server locally by using Group Policy
Management tools directly on the server, that method is not consistent or
efficient when you have many computers to configure.
When you have multiple computers to manage, create and edit GPOs,
and then apply those GPOs to the computers in your organization.
Common scenarios, including firewall rule deployment, server and domain
isolation, and IPsec tunnel mode configuration are discussed.

Download the Article [https://www.microsoft.com/en-us/download/details.aspx?id=11698]






          

      

      

    

  

    
      
          
            
  
How do I block a specific IP from my server?

windows Firewall

First, you will need to open the IPSec snap-in:


	Start -> Run -> mmc


	File -> Add/Remove Snap-in…


	Add…


	IP Security Policy Management (Not to be confused with IP Security Monitor)


	Local Computer




Highlight Security Policies on Local Computer


	In the right pane, right-click and choose Create IP Security Policy…


	This will start the IP Security Policy Wizard.


	Choose Next Enter a Name: and Description:


	UN-CHECK Activate the default response rule. Leave Edit properties
checked


	and click Finish




Under Rules choose Add… This will start the Security Rule Wizard.


	Hit Next


	This rule does not specify a tunnel.


	Local area networks (LAN)


	This will open the IP Filter List


	Choose Add…


	Enter a Name: and Description: Use the IP as the name for
identification purposes.


	Choose Add…


	Next


	Description: is optional here, though I’d put the IP to block again…


	UN-CHECK Mirrored. match packets with the exact opposite source and
destination address.


	For Source address: Use the Drop-down to choose A specific IP
Address and enter the IP address to IP to be blocked.


	Next


	For Destination address: Use the Drop-down to choose My IP Address


	Next


	For Select a protocol type: leave the drop-down on Any


	Next


	Make sure Edit properties is unchecked and Click Finish




This will return you to the IP Filter List press O to close it.


	You will now see and should select the radial for the filter list you just
created.


	Next


	This will open Filter Action


	Choose Add…


	Next


	Enter a Name: and Description: This action is simply for blocking
traffic so name it BLOCK


	Next


	Select the Block radial


	Next


	Make sure ‘Edit properties’ is unchecked and Click Finish




This will return you to the Filter Action selection You will now see and
should select the radial for the filter action you just created. Make sure
‘Edit properties’ is unchecked and Click ‘Finish’

Click OK to close the Policy you’ve just created.

The new policy should now show up in the right pane… to activate it, simply
right-click and choose assign

More information can be found in this downloadable guide from Microsoft:
here [https://www.microsoft.com/en-us/download/details.aspx?id=11698]






          

      

      

    

  

    
      
          
            
  
Drives not appearing in Windows 2008 installer.

On Windows 2008 R2 64-bit systems, the Setup program tries to load Inbox
storage drivers first, by default. As a result, you must load the driver
for Adaptec Series 6/6Q/6E/6T controllers TWICE.

The first time you load the driver, the OS displays the message
“No drives were found’. Select ‘Load Driver’ again, uncheck
“Hide drivers that are not compatible…’, then select the Series 6
controller driver. On the second attempt, the driver will load successfully.






          

      

      

    

  

    
      
          
            
  
Abuse


Contents:


	How do I configure Exim for better logging?

	How can I tell if I’m being attacked?
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	How can I proactively stop Phishing?
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How do I configure Exim for better logging?

What will these instructions do?

What this addition does is it adds valuable logging information to your
exim_mainlog file so that you can determine where messages are coming from,
whos sending the message and from what directory on your server the user NOBODY
is originating from, if your seeing mail leaving as nobody. In addition, it
adds very useful information to exim_mainlog to help you decipher email coming
and going.

Here is an example

2003-06-27 14:06:18 cwd=/home/usersite/public_html/forums 3 args:
                    /usr/sbin/sendmail -t -i
2003-06-27 14:06:18 19W0QE-0001Nr-1b nobody@yourserversname.com from env-from
                    rewritten as ""usersite.com" <minx@usersite.com>" by rule 1





The message above tells me where the message came from, who sent it from my
server, the user and the path it was called from. It also tells me how it was
called and what it was renamed to before leaving my server.

The message below, tells me an incoming message arrived with the subject line
= “Naked Newsreaders? OH YEAH!”. Very helpful in determining spam. You will see
many other messages in exim_mainlog that you didn’t see before. Great for
debugging your message logs and catching spammers!

EG: 19W0bO-0001cY-Ej <= jessica@stripdownnews.com H=(one) [128.121.247.84]:52087
                     I=[64.246.38.122]:25 P=smtp S=2387
                     T="Naked Newsreaders? OH YEAH!" from jessica@stripdownnews.com





cPanel Servers

If your server is running cPanel, the instructions are very simple.


	Login WHM and go to Service Configuration / Exim Configuration Editor


	Click the “Switch to Advanced Mode” button


	Now you’ll see the WHM Exim configuration editor. This is essentially like
editing exim.conf but throught he online interface and it
will remember your changes where as if you edit the file directly through
shell it will not.


	In the first window which is empty you’ll need to insert the following:
log_selector=+all


	Go to the bottom and Save the changes, they will be applied and Exim will
restart.


	Success! You have added additioinal logging to your Exim mail server for
better tracking.




Non-cPanel Servers running Exim



	Open /etc/exim.conf

pico /etc/exim.conf







	Find this

Ctrl + W: hostlist auth_relay_hosts = *
#########################
Runtime configuration file for Exim #
#########################







	After hostlist auth_relay_hosts = * add the following:

log_selector = +address_rewrite +all_parents +arguments +connection_reject
               +delay_delivery +delivery_size +dnslist_defer +incoming_interface
               +incoming_port +lost_incoming_connection +queue_run +received_sender
               +received_recipients +retry_defer +sender_on_delivery +size_reject
               +skip_delivery +smtp_confirmation +smtp_connection +smtp_protocol_error
               +smtp_syntax_error +subject +tls_cipher +tls_peerdn







	The final result should look like this:

hostlist auth_relay_hosts = *

log_selector = +address_rewrite +all_parents +arguments +connection_reject +delay_delivery
               +delivery_size +dnslist_defer +incoming_interface +incoming_port
               +lost_incoming_connection +queue_run +received_sender +received_recipients
               +retry_defer +sender_on_delivery +size_reject +skip_delivery +smtp_confirmation
               +smtp_connection +smtp_protocol_error +smtp_syntax_error +subject
               +tls_cipher +tls_peerdn

#######################################
# Runtime configuration file for Exim #
#######################################







	Save and restart Exim

ctrl + X then Y
/etc/init.d/exim restart












Then you’re done!






          

      

      

    

  

    
      
          
            
  
How can I tell if I’m being attacked?

When experiencing a DoS or DDoS attack, the first thing you will most likely
notice is that your server is unresponsive or is very slow to respond.

Check your Bandwidth Graphs

The first thing you should do is check your server’s bandwidth graphs. You can
do this through our control panel by visiting your Bandwidth Statistics [https://one.limestonenetworks.com/servers/bandwidth.html?range=day]
page and viewing the past 24 hours or even the past hour alone. If you see that
your traffic has spiked and the port is fully saturated (or close to it), you
are most likely under attack.

Please note that the Enterprise DDoS Protected IP’s will not show in the
Security Center and the bandwidth stats will not show the attack unless the
protection is failing.

Identify and Block Attackers

If you have some connectivity to your server, you can attempt to block some of
the attack by blocking IP addresses having several connections to your server.
Use the following command to list your active connections by IP address:

netstat -ntu | awk '{print $5}' | cut -d: -f1 | sort | uniq -c | sort -n





You can then use IP Tables, or the firewall of your choice, to block all
traffic from that IP address.

An IP Tables example would be:

/sbin/iptables -I INPUT -s x.x.x.x -p tcp -j DROP
/sbin/iptables -I INPUT -s x.x.x.x -p udp -j DROP





This would cause all TCP and UDP traffic to be dropped from this specific IP
address (represented by x.x.x.x).

Helpful Articles on Blocking Attackers


	
	WHT – DDoS Deflate [http://www.webhostingtalk.com/showthread.php?t=877639]

	
	(D)DoS Deflate is a lightweight bash shell script designed to assist in
the process of blocking a denial of service attack. It utilizes the
command below to create a list of IP addresses connected to the server,
along with their total number of connections. It is one of the simplest
and easiest to install solutions at the software level.










	
	cyberciti.biz – tcptrack [https://www.cyberciti.biz/faq/rhel-track-monitor-tcp-connections-on-network/]

	
	tcptrack is a sniffer which displays information about TCP connections it
sees on a network interface. It passively watches for connections on the
network interface, keeps track of their state and displays a list of
connections in a manner similar to the unix ‘top’ command. It displays
source and destination addresses and ports, connection state, idle time,
and bandwidth usage.












Notify Limestone

If you have no connectivity to your server, or the blocks you have put into
place are not stopping the attack, open a ticket with our Support department.
We will do our best to mitigate the attack and restore connectivity to your
server quickly.






          

      

      

    

  

    
      
          
            
  
How Do I Remove My IP From Trend Micro’s DUL

If you encounter issues sending e-mail due to a listing in Trend Micro’s DUL
(Dial-up/Dynamic User List) the steps outlined below will walk you through how
to get your IP removed.

Trend Micro will list IP addresses in their DUL if they do not meet their
requirements. In order to have your IP(s) removed you need to change your rDNS
in our control panel and e-mail Trend Micro’s DUL Team.

Please confirm your IP is listed [https://www.ers.trendmicro.com/reputations/index]
in the DUL before contacting Trend Micro.Below are Trend Micro’s
recommendations regarding delisting.

At this time, your rDNS looks like this, which looks dynamic.
This is what we call a generic naming convention:

192.168.0.1 (1-0-168-192.reverse.lstn.net)

If this IP is indeed static, then the rDNS needs to resolve to static.
Here is 2 ways to do that.

1) Add the word "static" to the rDNS to reference static. For
example:
1-0-168-192.static.reverse.lstn.net

2) Change the rDNS to announce your server, for example:
mail.domain.com (this is preferable if this is your mail server)

Here are the naming conventions that we use to decide if an IP or
CIDR is static or dynamic.
Typical static rDNS terms:
bus, biz, colo, ded, fix, mta, perm, server, smtp, static, wsip.

Typical dynamic rDNS terms:
adsl, cable, dhcp, dialup, dsl, dyn, home, isdn, modem, pool, ppp, or res.





Trend Micro must see these changes prior to any removals. Once you have changed
your rDNS email dul@mail-abuse.org stating that you have changed your rDNS to
reference its static assignment and are requesting removal. An example e-mail
is below.

To: dul@mail-abuse.org
Subject: DUL Removal for 192.168.0.1
Body: The RDNS for 192.168.0.1 has been changed to reference that it is a static IP address.
I would like to request removal of this IP from the DUL.





If you have any questions or issues regarding these steps please open a support ticket [https://one.limestonenetworks.com/support/newticket.html].






          

      

      

    

  

    
      
          
            
  
What is Phishing?

Phishing is the criminally fraudulent process of attempting to acquire
sensitive information such as usernames, passwords and credit card details by
masquerading as a trustworthy entity in an electronic communication. In this
case we are speaking of Website forgery.

What do I need to do?

If you receive an abuse notice that a phishing site is detected on your server,
action is required on your part.

In the ticket you will find the domain and IP address that the phishing website
is located on. We ask that you suspend or remove the website immediately and
reply back to the ticket letting us know the action taken.






          

      

      

    

  

    
      
          
            
  
How can I proactively stop Phishing?

Internally, Limestone Networks has been using the help of PhishTank [https://www.phishtank.com/]
to report phishing websites to our clients.
Recently we made this feature available directly to our clients within our
control panel. You can access it by clicking on the Servers tab and then
clicking phishing sites.






          

      

      

    

  

    
      
          
            
  
Malicious Network Traffic

Why am I receiving this notification?

An abuse ticket will automatically be opened on your account when
Limestone Networks has received an abuse report for an IP address
currently assigned to your server.

What is Malicious Network Traffic?

Limestone Networks considers Malicious Network Traffic as any of
the following:

Port Scanning

An attack that sends client requests to a range of server port
addresses on a host, with the goal of finding an active port and
exploiting a known vulnerability of that service.

Malicious HTTP GET/POST requests

An attack against a web server to discover commonly used scripts or
software, with the goal of exploiting a known vulnerability in that
software.

Any type of unauthorized brute-force attack against another server

An attack used for trying many combinations of standard or frequently
used username and passwords (e.g.: root/password).
These attacks are commonly directed towards SSH and RDP services.

Why is my server sending out malicious network traffic?

This type of activity typically occurs because a malicious script or
program was installed on the server. This may have been due to a compromise
of the server’s security or by a user granted access to your server.

Common Attack Vectors


	Login credentials have been brute forced or compromised


	User visited a malicious website and malware was installed without
their knowledge


	A vulnerability in website software allowed the attacker to upload a
malicious script


	A user knowingly installed malicious scripts/software on the server.




How can I identify the script or software responsible?

If your operating system is Linux we suggest using the “ps” command to
view the running processes on the system.

How to show all running processes in Linux [https://www.cyberciti.biz/faq/show-all-running-processes-in-linux/]

If your operating system is Windows we suggest downloading and running
Process Explorer from Microsoft. Process Explorer is a more advanced version
of Windows Task Manager. You can use this program to help identify processes
running on your system that you do not recognize. You can also find where on
your system a process is running from and what connections to the internet it
is making.

Download Process Explorer [https://docs.microsoft.com/en-us/sysinternals/downloads/process-explorer]

Resources:

http://en.wikipedia.org/wiki/Port_scanner [https://en.wikipedia.org/wiki/Port_scanner]
http://en.wikipedia.org/wiki/Brute-force_attack [https://en.wikipedia.org/wiki/Brute-force_attack]
http://la-samhna.de/library/brutessh.html [https://www.la-samhna.de/library/brutessh.html]





          

      

      

    

  

    
      
          
            
  
LSN Cloud CDN
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Information for the MineCraft Solution.

What is included in the Minecraft Solution?


	McMyAdmin 2


	Bukkit


	Essentials




What is the default login?

You can manage your server at http://{your_ip_address}:8080 with the username admin and the password

Password: We recommend that you change this password immediately.






          

      

      

    

  

    
      
          
            
  
Getting started with OnePortal Rapid

After your new cloud account [https://www.limestonenetworks.com/cloud/servers.html] is provisioned, you
will be able to log in to the cloud control panel [https://cloud.limestonenetworks.com/auth/login/?next=/] using your OnePortal
credentials.

[image: ../../_images/LSN_Cloud_Login_Page.png]
[image: ../../_images/Cloud_Account_Overview.png]
Security Groups

First, you should visit the Access and Security tab. This is where you will
find the configuration for Security Groups, Key Pairs (SSH Keys), and
API Endpoints.

First, let’s discuss Security Groups. By default, all outbound traffic from
instances is permitted, and all inbound is blocked. You will build security
groups to permit inbound services, and then assign the groups to your instances
to allow the traffic. To get started, click +Create Security Group.

Management – Remote Desktop and SSH access to your instances
Use the +Add Rule button to create SSH and RDP permit rules allowing
specific IP blocks or 0.0.0.0/0 (all traffic). Cloud Management Security Group

[image: ../../_images/manage_security_group.png]
SSH Key Pair

Cloud images distributed by most distro builders do not allow password login
upon install. Instead, they download SSH authentication key pairs which are
downloaded upon first boot by the instance and installed as authorized remote
users. In order to gain access to your instances on the LSN One Portal Rapid
Cloud, you will need to have a key pair added to the instance when it is
created.

Generate SSH Key

If you already have a key pair, skip to the Add SSH Key to OnePortal Rapid
section below.

[image: ../../_images/puttygen_SSH_key_generator.png]

	Navigate to the PuTTY SSH Client [https://www.chiark.greenend.org.uk/~sgtatham/putty/latest.html]
download page.


	Download putty.exe and puttygen.exe


	Open puttygen.exe and click Generate


	After generating the SSH key, save the private key file to your local
machine.


	Copy the public key file at the top of the puttygen dialog to your
clipboard, you will need it in the next step.




Add SSH Key to OnePortal Rapid

To add a key pair, navigate to Access and Security, and select the
Key Pairs tab. Then select Import Key Pair. Name the key pair and paste
your public key into the dialog box.

[image: ../../_images/Import_SSH_Key.png]
Once you have completed this step, you should see the key on your key pairs
page.

[image: ../../_images/Key_Pair_Added.png]
Creating an Instance

After creating your security group and key pair, we are ready to launch a VM!
Navigate to the Instances page and click  Launch Instance.

On the Details tab, name your instance, select a flavor, use instance count
1, boot from the image, and select an Image to boot the instance from.

[image: ../../_images/Cloud_Launch_Instance_Details.png]
Under Access & Security, select your key pair and security group**(s)
that will permit inbound traffic to your instance. In the **Networking tab,
select network(s) to attach the instance to. Most images only configure the
first NIC upon boot, so for testing select Public Internet.

[image: ../../_images/Cloud_Launch_Instance_Networking.png]
Now click Launch, and the instance will be deployed in the cloud.

[image: ../../_images/Cloud_Launched_Instance.png]
Connect to the Created Instance

To access the launched instance, open PuTTY and navigate to the
Connection > SSH > Auth settings. Set the
“Private key file for authentication” to the private key file you generated
earlier.

[image: ../../_images/PuTTY_Key_Configuration.png]
Then select the Session tab and enter the user@hostname for your instance.
By default, CentOS instances are configured with a centos user, Ubuntu uses
an Ubuntu user, and Fedora has a fedora user.

[image: ../../_images/Public_Cloud_Test_Instance_PuTTY.png]
[image: ../../_images/Cloud_Test_Instance_PuTTY_Connection.png]
About Volumes and Instance Boot Disks

Think of volumes in OnePortal Rapid as hard drives that can be attached and
detached from instances without losing their data. They can be based on OS
images, instances can boot from volumes instead of the boot disk included with
the instance, or you can use volumes as bulk storage devices for user data.

For the OnePortal Rapid cloud, we have SSD and HDD volume types
available. SSD volumes are provisioned on flash storage, and HDD
volumes are provisioned on 7200 RPM drives with SSD flash-based journaling.
Both volume types include 3x data replication enabling self-healing in the
event of a disk or node failure on the cluster. Instance boot disks are
equivalent to fixed-size SSD volumes.

Creating and Attaching Volumes

To create a volume, select the Volumes page and click +Create Volume.
In the dialog, enter a volume name, select a volume type, and enter a disk size
for the volume you are creating.

[image: ../../_images/Cloud_Create_Volume.png]
After creating the volume, select the drop down for the volume on the dashboard
and click Manage Attachments. Now select your test instance and attach the
volume to it.

[image: ../../_images/Cloud_Attached_Volume.png]
Confirm the volume has been attached to the instance:

[image: ../../_images/Cloud_Attached_Volume_SSH.png]
To detach the volume, navigate back to the Manage Attachments page and
detach the volume. It will then be made available for deletion or attachment to
another instance.






          

      

      

    

  

    
      
          
            
  
What type of virtualization is used for cloud servers?

There are a few main virtualization types: KVM, VMWare, OpenVZ and Xen. Out of
them, we chose KVM because it has been proven to be the fastest. This is mostly
due to how highly integrated it is with the hypervisor’s kernel.




Nested KVM

Nested KVM is not supported at this time. It is still a young concept and we
will continue to watch for it to be production ready. You can however purchase
Citrix XenServer and run Xen within our cloud.






          

      

      

    

  

    
      
          
            
  
Creating security groups for cloud VMs

Security Groups can be created and managed in the “Access and Security”
tab of the control panel under the “Security Groups” tab.

[image: ../../_images/securitygroups.png]
Press the “Create Security Group” button to begin.
Give the group a name and description and press the “Create Security Group”
button.
Once created you can create the rules for the group by pressing the “Manage
Rules button” under the “Actions” tab.

[image: ../../_images/rules.png]
Here you can set rules for both IPv4 and IPv6 protocols.
To create a rule press the “Add Rule” button.

[image: ../../_images/addrule.png]

	Rule Here you can choose the type of rule you would like to create.


	Direction Ingress is for all traffic incoming to the server. Egress is
for all traffic coming from the server.


	Open Port allows you to choose whether this rule will be for a specific
port or range of ports


	Port Input your port or range of ports here.


	Remote allows you to choose whether this rule will be for a set IP range
(CIDR) or members of an existing security group (Security Group)


	CIDR Input the IP range that will be affected by this rule.




Press the “Add” button to create the rule.






          

      

      

    

  

    
      
          
            
  
Cloud Key Pairs

Key pairs are necessary for Cloud VM access.
Key pairs can be created or imported in the “Access and Security” tab in
your Cloud control panel.

[image: ../../_images/keypairs.jpg]
Creating a key pair in the control panel will allow you to download a private
key file which you can import into your ssh application or service.
You may also import a keypair using the public key that you have generated
elsewhere.

[image: ../../_images/importkey.jpg]

	Key pair name Enter the key pair name of your choosing.


	Public key Paste your previously generated public key here.




Once a keypair has been added you may use it when creating a new VM.






          

      

      

    

  

    
      
          
            
  
How to create a new Virtual Machine.

Log into your cloud control panel and click the “Instances” tab.

From here Press the “Launch Instance” Button

[image: ../../_images/LaunchInstance.jpg]
Details

[image: ../../_images/Capture.jpg]

	Availability Zone is the database location. Currently only our Dallas
location is available.


	Instance Name allows you to name your VM.


	Flavor lists preset VM sizes you can chose from. Flavor details are
listed to the right.


	Instance Count allows you to specify how many of this VM you would like
created.


	Instance Boot Source provides a list of operating systems that can be
installed along with Bitnami pre-configured operating systems as well as VM
snapshots.


	Boot from snapshot allows you to create a VM mirrored from a premade
snapshot of yours.


	Boot from Volume allows you to customize your bootable storage type and
size by using Volumes. For more information on Volumes see this knowledge
base.




Access and Security

[image: ../../_images/AccessandSecurity.jpg]

	Key Pair You will need to select a key pair upon VM creation for the
server to be accessible.
http://support.limestonenetworks.com/knowledge-base/cloud-key-pairs/


	Security Group allows you to configure access to the VM and is necessary
for VM use. Security groups can be added or changed at any time.
http://support.limestonenetworks.com/knowledge-base/creating-security-groups-for-cloud-vms/




Networking

[image: ../../_images/Networking-tab.jpg]
VMs can be configured with a public and private network.
Public network allows the server to be accessed from the internet.
Private network allows the server to be connected to from another VM over the
same network.
IMPORTANT! If you add a Public Network it MUST be set as NIC1 to be
accessible from the internet.

Post Creation

[image: ../../_images/Post.jpg]
From here you can add script or a set of commands to be run on the server after
creation.

Advanced Options

[image: ../../_images/advanced.jpg]
Disk Partition From you can choose to either have the disk partitioned
automatically or manually.

Finish

Once you’ve configured the VM to your preference press the “Launch button” and
the VM will be created.






          

      

      

    

  

    
      
          
            
  
Can’t access your new cloud instance?

If you’ve just created a new cloud instance but are unable to connect to it,
there are a few quick things you can check.


	Did you add your Key Pair to the instance before creating it?


	Did you add a Security Group to the instance that allows for SSH/RDP
connections?


	When configuring the network of the instance did you add your Public Network
as NIC1?


	If using Windows, have you retrieved the Windows Admin password?




If you’re still having issues connecting please create a Support ticket and
we’ll be more than happy to assist.






          

      

      

    

  

    
      
          
            
  
Cloud Volumes

Volumes act as detachable storage that can be connected to any of your VMs
for storage or bootable media.
To create a new Volume Press the “Create Volume” Button in the Volumes tab
of the control panel.

[image: ../../_images/Volumes.jpg]
[image: ../../_images/createvolume.jpg]

	Volume Name input the name of the volume here.


	Description input the description of the volume here.


	Volume source Select “No source, empty volume” if the volume will be used
for storage only. If you would like the volume to be bootable you will need
to select “Image” here. A new drop down box will appear and allow you to
choose an image to be installed onto the volume.


	Use image as source To use the volume as bootable storage for a new VM you’ll
need to select which OS to be installed. See this Link for details.


	Type allow you to choose SSD(Solid state drive) or HDD(Hard disk drive) as
your storage type. SSD storage is faster but more expensive and HDD storage
is slower but less expensive.


	Size allows you to choose the size of the volume in GBs.


	Availability Zone Currently there is only one option which is our Dallas
location.




Press “Create Volume” to create the volume
Once created you can attach the volume to a VM using the drop down box under
“Actions” With the “Manage Attachments” button.






          

      

      

    

  

    
      
          
            
  
How long does it take for a cloud server to be created?

Most cloud servers are provisioned in less than 5 minutes.
Microsoft Windows servers may take up to 10 minutes, however,
we are working to make this faster.






          

      

      

    

  

    
      
          
            
  
How is the data stored in the cloud?

The storage for the cloud is made up of a distributed SAN.
All of the SSD drives in the hypervisors are part of a striped and mirrored
RAID over a special storage network. Your instance is primarily stored
on the hypervisor that is serving it for quick access,
making our setup both Local and SAN.






          

      

      

    

  

    
      
          
            
  
How fast is the network connection on cloud servers?

Cloud servers are capable of up to 1Gbps.
While we make gigabit standard for cloud servers,
most of our competitors limit their instances to 100Mbps or less.






          

      

      

    

  

    
      
          
            
  
How does the billing work for cloud servers?

When purchasing a cloud server you are given the opportunity of choosing
between hourly or monthly billing. If you choose hourly, a minimum deposit
of $5 is required it your cloud server(s) will deduct from that amount hourly.






          

      

      

    

  

    
      
          
            
  
How do backups work for cloud servers?

At this time, you can use our Shared NAS to store backups that you make
through your operating system. In the future,
we will add an easy snapshot feature.






          

      

      

    

  

    
      
          
            
  
Does LSN Cloud support nested KVM environments?

No, nested KVM virtualization is considered unstable.
As the technology advances, we will certainly look into it in the future.

You can, however, order Citrix XenServer in our cloud.






          

      

      

    

  

    
      
          
            
  
you offer Windows on cloud servers?

Yes, there are various Microsoft Windows options on our order form for
the cloud. The provisioning time is slightly longer (under 10 minutes)
due to the way the filesystem works for Windows.

Additionally, we offer Windows desktop environments like Windows 7 and
Windows 8 so that you may create a cloud server to run as a virtual desktop.






          

      

      

    

  

    
      
          
            
  
Do you offer management for my cloud server?

Although our standard support is unmanaged, we have two management
plans you can choose from depending on the level of management you need.
More information can be found here:

Managed Cloud [https://www.limestonenetworks.com/support/managed-servers.html]






          

      

      

    

  

    
      
          
            
  
Do I have full control over the software on the cloud server?

Yes, you receive the administrator password for Windows or the root
password for Linux. These logins give you full control.






          

      

      

    

  

    
      
          
            
  
Can I SWIP my IP address(es) for cloud servers?

Unfortunately SWIP isn’t possible for cloud servers, however,
our Public Cloud Reseller and Private Cloud offerings will have that ability.






          

      

      

    

  

    
      
          
            
  
What kind of uptime can I expect for the cloud?

Although our company’s SLA promises a 99.9% uptime,
the cloud is built for 100% uptime. The network switches,
hardware and storage are all redundant to the point to where
downtime would be extremely difficult under normal circumstances.






          

      

      

    

  

    
      
          
            
  
How to configure a new Cloud instance’s drive type and storage.

If you’re looking to create a VM with a custom storage size and type,
you’ll want to create a new Volume.

Once you’ve created the volume you can use it to launch a new VM.

[image: ../../_images/bootfromvolume.jpg]
When launching your new instance make sure you select Boot from volume
in the Instance Boot Source drop down box.

This will open up a new drop down box which will allow you to choose which
Volume you would like to have the VM boot from.






          

      

      

    

  

    
      
          
            
  
Connecting to your Windows cloud instance.

Once you have created a Windows instance you’ll need to retrieve the
Admin password.

[image: ../../_images/windowspass1.jpg]
The Admin password is encrypted using your Key Pair. To decrypt it,
you’ll need to retrieve your Private Key.

[image: ../../_images/decrypt.jpg]
You can either paste the private key or upload a private key file.
Afterwards just hit the “Decrypt Password” button to retrieve the
Admin password.

Now that you’ve got the Admin password you can use Remote Desktop to
connect to your Windows instance.






          

      

      

    

  

    
      
          
            
  
Is there a firewall for the cloud servers?

Cloud servers work exactly like dedicated servers when it comes to security.
You may use the firewall within the operating system to apply protection.
However additionally you may use the firewall settings in OnePortal to protect
your cloud server at the hypervisor level– meaning the traffic doesn’t make
it into your cloud server.
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More about LSN’s CDN Performance

Hardware/Network Performance

LSN CDN is a globally distributed network of servers containing at least:


	100% SSD storage


	2000+ IOPS


	20GB RAM


	1.5Gbps Uplink


	99.3% uptime per node (100% uptime combined)




Geographical Placement

LSN CDN has Points of Presence (PoP) in the following locations, spread out for
optimal placement:


	Seattle, WA (US)


	Los Angeles, CA (US)


	Dallas, TX (US)


	Chicago, IL (US)


	Arlington, VA (US)


	New York, NY (US)


	Miami, FL (US)


	Sao Paulo (BR)


	London (UK)


	Prague (CZ)


	Singapore (SG)


	Ankara (TR)


	Sydney (AU)









          

      

      

    

  

    
      
          
            
  
How does CDN pricing work?

With LSN CDN you are only billed for bandwidth and not storage fees.
When ordering CDN service you choose the amount of bandwidth you plan to use
during the billing month. Don’t worry, if you are close to going over your
bandwidth you can upgrade any time.

See our prices [https://www.limestonenetworks.com/order/order.html?id=78].






          

      

      

    

  

    
      
          
            
  
What is the Country ACL?

The Country Access List (or Access Policy) is a feature of the LSN CDN that
allows you to only allow certain countries access to your files.

Block Certain Countries

By default no countries are blocked. If you would like to block certain
countries from accessing the files on your CDN, please do the following.


	Login to OnePortal’s cdn.html” target=”_blank”>CDN setup page.


	Click “Modify Country Access Policy”.


	Click “Allow All By Default”.


	Under “Exceptions” drag the countries you would like to block access for
from the “Available Countries” column to the “Selected Countries” column.


	Press “Save Changes”.




Block All but Certain Countries

If you would like to block all but a few countries, here is how you would do
it.

By default no countries are blocked. If you would like to block certain
countries from accessing the files on your CDN, please do the following.


	Login to OnePortal’s cdn.html” target=”_blank”>CDN setup page.


	Click “Modify Country Access Policy”.


	Click “Deny All By Default”.


	Under “Exceptions” drag the countries you would like to enable access for
from the “Available Countries” column to the “Selected Countries” column.


	Press “Save Changes”.




Allow Access to All Countries

To completely re-enable access to all countries, do the following.


	Login to OnePortal’s cdn.html” target=”_blank”>CDN setup page.


	Click “Modify Country Access Policy”.


	Click “Allow All By Default”.


	Drag all countries under “Selected Countries:” to the “Available Countries”
column.


	Press “Save Changes”.









          

      

      

    

  

    
      
          
            
  
What is Spider Blocking?

Spider blocking is a feature of the LSN CDN that allows you to block Google
from indexing your CDN content.

How to Enable Spider Blocking


	Login to OnePortal’s cdn.html”>CDN setup page.


	Click “Other Options”.


	Under “Block Bots” select “On”.


	Click “Save Changes”.









          

      

      

    

  

    
      
          
            
  
What is Password Protection?

The Password Protection feature of LSN CDN allows you to only allow certain
people access to your content. These people must login with a username and
password.

How to Enable Protection


	Login to OnePortal’s cdn.html” target=”_blank”>CDN setup page.


	Click “Modify Password Policy”.


	Click “Enabled”.


	Click “Add new user”, enter a username and password for the new user and
click “Save Changes”.


	Repeat the previous step for any users you would like to add.


	click “Save Changes” when finished.









          

      

      

    

  

    
      
          
            
  
What is MP4/FLV Streaming?

Format Recommendation

Most of the players do not support MPEG-4 encode, you are advised to use h264
videos.

Start-End Parameter

By default, videos will play at the beginning and play through till the end,
however, you can customize that through the URL.

MP4 pseudo streaming’s “start” and “end” are in seconds unit. For example, you
could use the URL:

http://example.com/something.mp4?start=12.34&end=55.66 (12.34, 55.66 in
seconds)

FLV pseudo streaming’s “start” is in bytes unit (no “end” for FLV pseudo
streaming). For example:

http://example.com/something.flv?start=1200






          

      

      

    

  

    
      
          
            
  
What is Hotlink Protection?

Hotlink protection is an optional feature to the LSN CDN that allows you to
protect your bandwidth by disallowing other domains from linking to content
(images/videos/files) you have on the CDN.

Block Hotlinking By Default


	Login to OnePortal’s cdn.html” target=”_blank”>CDN setup page.


	Click “Modify Hotlink Policy”


	Click “Block All By Default”


	Click “Add Domain” and add all domains and subdomains you want to be able
to link to your content.






	Example: limestonenetworks.com


	Example: www.limestonenetworks.com








	Click “Save Changes” after each domain you add.


	After adding all the domains you want to enable hotlinking for, click
“Save Changes”




Block only Certain Domains


	Login to OnePortal’s cdn.html” target=”_blank”>CDN setup page.


	Click “Modify Hotlink Policy”


	Click “Allow By Default”


	Click “Add Domain” and add all domains and subdomains you want to block from
linking to your content.






	Example: bad-domain.com


	Example: www.bad-domain.com








	Click “Save Changes” after each domain you add.


	After adding all the domains you want to block hotlinking for, click “Save
Changes”




Disable Hotlink Protection

Hotlink protection is disabled by default, however, if you have enabled it then
you can disable it by doing the following.


	Login to OnePortal’s cdn.html” target=”_blank”>CDN setup page.


	Click “Modify Hotlink Policy”


	Select “Allow All By Default”


	Click the red “[X]” next to each domain. If you do not, those domains will
be blocked.


	When finished, press “Save Changes”









          

      

      

    

  

    
      
          
            
  
How to setup SSL Support

The Basics

If your web site uses SSL anywhere on it, such as an order form, we would
highly recommend that you use this SSL-supported setup site-wide.

The Steps


	Login to OnePortal’s cdn.html” target=”_blank”>CDN setup page.


	Click “Modify Hostname”.


	Turn “SSL” into the “On” position and press “Save Changes”.


	You will be given a hostname like “yourdomain.com.r.worldssl.net” to point
your web addresses to.


	Make sure your hosting has a domain alias setup for the hostname provided in
the pervious step.
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WHMCS module Welcome Email template update

The OnePortal module for WHMCS update includes a “OnePortal Welcome” email
template to replace the default WHMCS “Dedicated/VPS Server Welcome Email.”
The default template included in WHMCS assumes that all servers are licensed
with WHM. This white-label template included in the OnePortal module update
works with any server.

Adding the OnePortal Welcome replacement template


	In WHMCS Admin, navigate to Setup->Email Templates


	Create New Email Template Type: Product/Service


	Name the template “OnePortal Welcome” or another Unique Name


	Enter a subject of “New Server Information” or similar


	Click “Enable/Disable Rich-Text Editor” so that rich-text is disabled


	Open the oneportal_welcome_text.txt file


	Copy and paste the plain text from oneportal_welcome_text.txt into the new
email


	Save Changes


	If you have already created the products in WHMCS for the OnePortal module:






	For each server, in Setup->Products/Services->Products/Services, select to
edit the product


	In the Details tab, change the Welcome Email to “OnePortal Welcome” or the
unique name you created for the new template


	Save Changes








	If you have not yet created the products in WHMCS:






	When creating each server, under the Details tab, ensure that “OnePortal
Welcome” or the unique name of the new template is selected







Ensuring the Merge Fields are filled correctly on the template (additional
required steps for WHMCS 6.2 or earlier)


	For each dedicated server or cloud server you sell through the OnePortal
WHMCS module, create a server in Setup->Products/Services->Servers->Add New
Server






	For Name, enter whatever you would like (easiest to enter server Hostname)


	For Hostname, enter the server Hostname


	For IP Address, enter the primary IP Address of the server


	For Assigned IP Addresses, enter all of the IP Addresses of the server,
including the primary IP Address (one per line)


	Monthly Cost, Datacenter/NOC, and Server Status Address are optional fields
(they are irrelevant to the email template)


	Maximum No. of Accounts is recommended to be “1”


	Fill in the Primary Nameserver and Secondary Nameserver fields


	In Server Details, for Type, choose Oneportal


	Username – “root”


	Password – enter root password of server


	Save Changes








	Go to the Client Profile for your new server order, under the
Products/Services tab


	For Server, select the server created in Step 1 from the dropdown list


	Save Changes




Now the product welcome email will appear similar to:

[image: ../_images/whmcs_email_template.png]





          

      

      

    

  

    
      
          
            
  
WHMCS Reseller Modules – Best Practices

This article presents some best practices with regard to configuring WHMCS to
work with the Limestone Networks API modules for remote server administration.
Any information contained in this article is meant to serve as an auxiliary
resource and is not a substitute for the installation instructions included in
the official Github repository [https://github.com/limestonenetworks/oneportal-whmcs].

Dedicated Servers – Best Practices

When getting started with dedicated servers [https://www.limestonenetworks.com/dedicated-servers/bare-metal.html], it is
recommended to use the Opserverimport Addon Module [https://marketplace.whmcs.com/product/3931] in conjunction with the
OnePortal server module, as this combination provides the ability to create a
complete replication of all products and configurable options available in a
matter of seconds. For those who are looking to further customize a more unique
offering, the aforementioned module combination is still highly recommended as
a time-saver since deactivating or hiding products and configurable options can
be accomplished very quickly using the native WHMCS web-interface or, for those
serious WHMCS admins, by modifying the database tables directly.

All products and options are assigned default prices which mirror the LSN
website pricing. Partners and resellers are encouraged to modify price and any
other aspects as per their business requirements.

Cloud Servers – Best Practices

When adding cloud servers as products, it is best to consider how you plan to
display them on your site. The “cloud slider” is a popular interactive display,
which allows your clients to choose between 3-6 different preconfigured cloud
instances before making the next step to configurable options, where they can
further customize the cloud server resources to their specific needs.

Initially, when adding the configurable options for cloud servers, adding all
available configurable options to one configurable options list is recommended.
Then duplicate the list for each different preconfigured server you are going
to display and tick the boxes to hide each irrelevant option. Adjust the
pricing for the remaining options accordingly (i.e. if your preconfigured
server has 2 cores, 4GB RAM, & 60GB SSD drive, you would hide the options for
1 core, 2GB RAM, 40 GB SSD, etc. as they are irrelevant to this preconfigured
server). Ultimately, this will be entirely up to you to customize.

How the API Interacts

For dedicated servers, when an order is placed through your website, the
WHMCS API module does not provide automatic product “provisioning”, as all
servers are custom-built and tested by server technicians to ensure quality and
accuracy. In an effor to provide consistent, high-quality server hosting, a
quick trip to the Limestone Networks server order form is required. When the
server is live, you are notified in your OnePortal account and via email.
Generally, this is within 1-4 hours of the server being ordered at our website.

We are always working to improve the workflow, so as to better suit our
partners, so we do appreciate any suggestions and feedback from resellers.

With cloud servers, utility-style billing methods are employed to make
instant provisioning of your cloud a reality. When our system receives an
order, our API will automatically provision the new server to your client
through your account on an hourly billing basis. In order for this process to
start, the OnePortal account must have a minimum of $5.00 USD balance in the
Cloud pool.

Bonus Content

Partners are welcome to contact us via OnePortal ticket to have the invoice
converted to monthly billing, if desired.

Regarding support, partners of Limestone Networks will act as the first line
of support to their clients. However, you may pass support requests to us on
behalf of your clients. Please contact the sales department with any questions
you have regarding the Reseller Program, the tools available, or to receive a
server quote for your custom requirements.
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Do you accept prepaid credit cards?

Unfortunately due to the high level of fraud associated with prepaid credit
cards, Limestone Networks does not accept these types of credit cards.
Unfortunately our Verifications department is unable to bypass this policy for
any reason.






          

      

      

    

  

    
      
          
            
  
What payment types does Limestone accept?

Limestone Networks accepts all major credit cards as well as
PayPal and Bitcoin.


	Visa


	Mastercard


	Discover


	PayPal


	Bitcoin




If you would like to use an American Express card,
simply choose the PayPal option during check-out.






          

      

      

    

  

    
      
          
            
  
What is currently on sale?

You can see our current specials here:

Current LSN Specials. [http://l.limestonenetworks.com/currentspecials/]

This URL will always redirect you to the current sale,
so stick it in your bookmarks.






          

      

      

    

  

    
      
          
            
  
Contributor Guide

Thank you for taking the time to contribute! The following is a set of
guidelines for contributing to limestonenetworks/knowledge-base.
These guidelines are related to adding new articles or editing
existing articles from KB.


	Make sure that you have a github account [https://github.com/join].


	Fork the limestonenetworks/knowledge-base [https://github.com/limestonenetworks/knowledge-base] repository on github.




[image: _images/fork_2.png]

	Once you have forked the repository, it will become your personal
repository.




[image: _images/fork_3.png]

	Under /doc/source/ you can see different folder(sections)
that we have. Please navigate to the intended section, for example
I want to add an article to operatingsystem_support/linux_support/
click on create new file.




[image: _images/add_article_4.png]

	Provide the article name with .rst extension.




[image: _images/add_article_5.png]

	You can use online RST compiler [http://rst.ninjs.org/] to preview
and edit your article.




[image: _images/compiler_6.png]

	Please dont forget to mention the .. disqus:: tag at the bottom
of the article as shown.




[image: _images/disqus_7.png]

	After you are done with writing the article, commit the new file
at the bottom of the page. You can commit it to a Master branch
or can create new branch.




[image: _images/commit_new_file_8.png]

	New article will show up as added to the folder.




[image: _images/file_added_9.png]

	You will also need to edit the linux_support.rst index file under
operatingsystem_support/ folder.




[image: _images/add_to_list_10.png]

	At this point you are ready to open a Pull Request (PR),
click on New pull request.




[image: _images/pr_1.png]

	Click on the Create pull request.




[image: _images/pr_2.png]

	Give a suitable title and hit Create pull request.




[image: _images/pr_3.png]

	If everything is correct then you should see All checks have passed.




[image: _images/pr_4.png]

	If there are errors then PR will fail mentioning the reason for failure.
Most of the time error will be related to the formating of the article
as articles are set for doc8 [https://pypi.org/project/doc8/]
standard.


	Administrator of the limestonenetworks/knowledge-base will review
it and suggest the changes if needed before merging them.
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VMWare ESXi 6.5 root Account Lockout


Account Lockout:

VMWare ESXi 6.0 and above include a new security feature to protect your from
unwanted access and in some cases brute force attacks.
In this article we will be using ESXi 6.5.

What is a brute force attack?
A brute force attack is a method of trial-and-error (guess work) to obtain user
information, typically a password. An attacker will use automated software to
guess the password, normally for the root or administrator user accounts, on a
continuous basis.

When an attacker attempts to brute force their way in or a user simply forgets
the root password and triggers the account lockout the ESXi 6.5 system will
disable the root account from being able to access the vSphere web client for
15 minutes by default. if the system is under a brute force attack it will have
hundreds if not thousands of failed login attempts, due to this, the system may
become inaccessible for an indefinite amount of time. The following steps will
show you how to regain access to your hosts vSphere web client and how to
either disable this feature (This is not recommended) or by pass it
completely.

Recommended Action

First you will need to restart the management agents. The following steps will
walk you through how to do this but you will need to be logged into the
KVMoIP-IPMI [https://bit.ly/2K4awBp].


Login to your server
Click on Troubleshooting Options → Restart Management Agents
→ Press F11 to restart agents, here you’ll see that you also have an
option to Collect extra troubleshooting information. Check the box if
you’d like.




[image: ../_images/ManagementAgents1.png]
[image: ../_images/ManagementAgents2.png]
[image: ../_images/ManagementAgents3.png]
Now that you have access to the vSphere web client we’ll walk through the steps
of creating a new user and new roles which new users can be added to. This will
allow you to access the web client even if the root  account is locked, the
permissions this account has is entirely up to you.


Creating a new user is simple, click on Host → Manage
→ Security and users tab → click on users → then simply +Add user
Creating permissions - permissions or Roles are used to provide certain
users with a certain amount of access. Click on Host → Manage →
Security and users tab → here you will click on Roles which is
located right below Users → +Add role.

With the new user and role created, you’ll need to add this new user to the
new role. Click on Host → Actions this option will be located on
the Host window where you’ll find Hardware, Performance, and System
Information → click on Permissions → Add user → choose the user you
created → choose the role you created → click on add role at the bottom
right of the window you are in.

Now you can login using the new user account you have created. Keep in mind
however, the username you choose will need to be something an attacker is
unaware of or else you risk a brute force on that user account, it’s best
to keep away from publicly available information as a username.







Disable Security.AccountLockFailures

If you are currently locked out of the system and do not have another user
account you can access it with please refer here.


When you are logged into the root account go to Host → System tab
→ Advanced settings → in the top right copy and paste the following
into the search bar Security.AccountLockFailures → Setting this to 0
will disable root lockout.

Additionally, Security.AccountUnlockTime will change how long that
account stays locked. This setting is set to 15 minutes by default but
you will see 900 seconds in the Value portion.







Support

If you find yourself unable to move forward due to a technical issue or
just have questions regarding this process please open a support ticket.
We are here 24/7/365 and we’ll do our best to assist you.


	Sources:

	
	https://en.wikipedia.org/wiki/Brute-force_attack


	https://bit.ly/2OtVacW
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